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C H A P T E R  1  

Introduction 

This guide provides information on how to work in Parallels Management Console—a client 
application used to manage your Parallels physical servers and their virtual machines. 

In This Chapter 
About Parallels Management Console .................................................................................. 6 
About This Guide.................................................................................................................. 7 
Getting Help.......................................................................................................................... 9 
Feedback ............................................................................................................................... 10
 
 

About Parallels Management 
Console 

Parallels Management Console is a remote tool with a graphical user interface (GUI) for 
managing Parallels physical servers and virtual machines residing on them. This tool supports 
managing physical servers running the following Parallels products: 

 Parallels Server for Mac 
 Parallels Server Bare Metal 
 Parallels Server for Mac Bare Metal Edition 

Parallels Management Console uses a typical client-server architecture. 
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The client application with the graphical user interface is installed on a computer running one of 
the supported Linux, Mac, or Windows operating systems. For the full list of supported 
operating systems, see the Checking System Requirements subsection of the Getting Started 
With Parallels Management Console guide. Once the client application is up and running, it can 
connect to the Parallels Service software on a physical server. This software is automatically 
installed on the physical server when you install one of the aforementioned Parallels products. 
The client application can control multiple physical servers simultaneously (e.g. Physical Server 
#1 and Physical Server #2 as shown in the picture above). After the connection to the required 
physical server has been established, you can start managing this server and its virtual machines 
using the intuitive and comfortable GUI. 

Parallels Management Console Specifics 

When working with Parallels Management Console, pay attention to the following: 

 This guide uses the term Parallels Server Bare Metal to refer to both products: Parallels 
Server Bare Metal and Parallels Server for Mac Bare Metal Edition. 

 Some features described in this guide are specific for particular products and product 
versions (for example, only for Parallels Server 5 Bare Metal) and may be not available in 
your product. If a feature is available for a specific product only, we add a note to the place 
where this feature is described. 

 You can install the version of Parallels Management Console shipped with Parallels Server 
5 Bare Metal only on computers running Linux and Windows operating systems. 
Installation on Mac computers is not supported. 

 Some steps, option names, paths are different on Linux, Mac, and Windows computers. In 
this case, these differences are marked with the following icons: 

  for Windows specifics 

  for Linux specifics 

  for Mac specifics 
 

About This Guide 
Parallels Management Console User's Guide contains extensive information on configuring 
Parallels Management Console settings and using this application to manage Parallels physical 
servers and virtual machines hosted on them. 

To follow the instructions in this guide, no more than basic Linux, Mac, or Windows 
administration skills are required. 
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Organization of This Guide 
The structure of the present guide is quite transparent and consists of the following chapters: 

 Introduction (p. 6) (you are reading it now). Provides basic information about the product 
and this guide. 

 Getting Started With Parallels Management Console (p. 11). Provides basic information on 
how to work with Parallels Management Console. 

 Managing Parallels Servers (p. 23). Provides basic information on how to work with a 
Parallels physical server. 

 Setting up a Virtual Machine (p. 41). Provides instructions on creating a new virtual machine 
and adding an existing one. 

 Working in a Virtual Machine (p. 66). Provides basic information on how to work with virtual 
machines. 

 Configuring Virtual Machines (p. 80). Provides information on how to change the virtual 
machine configuration. 

 Managing Virtual Machines (p. 122). Provides basic information on how to manage your 
virtual machines. 

 Using Parallels Compressor (p. 143). Provides information on how and when you can use 
Parallels Compressor. 

 Troubleshooting and Limitations (p. 148). Provides the solutions for some of the known 
issues. 

 

Documentation Conventions 
Before you start using this guide, it is important to understand the documentation conventions 
used in it. 

The table below presents the existing formatting conventions. 

Formatting convention Type of Information Example 
Items you must select, such as 
menu options, command buttons, 
or items in a list. 

Go to the Resources tab.  

Special Bold 

 Titles of chapters, sections, and 
subsections. 

Read the Basic Administration chapter. 
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Italics Used to emphasize the 
importance of a point, to 
introduce a term or to designate 
a command-line placeholder, 
which is to be replaced with a 
real name or value. 

These are the so-called EZ templates. 

To destroy a Container, type vzctl 
destroy ctid. 

Monospace The names of commands, files, 
and directories. 

Use vzctl start to start a Container. 

Preformatted On-screen computer output in 
your command-line sessions; 
source code in XML, C++, or 
other programming languages. 

Saved parameters for Container 
101 

Monospace Bold What you type, as contrasted 
with on-screen computer output. 

# rpm –V virtuozzo-release 

Key+Key Key combinations for which the 
user must press and hold down 
one key and then press another. 

Ctrl+P, Alt+F4 

Besides the formatting conventions, you should also know about the document organization 
convention applied to Parallels documents: chapters in all guides are divided into sections, 
which, in their turn, are subdivided into subsections. For example, About This Guide is a section, 
and Documentation Conventions is a subsection. 
 

Getting Help 
In addition to this guide, you can use the following resources to get more information on 
Parallels Management Console: 

 Getting Started With Parallels Management Console. This guide provides information on 
installing and setting to work the Parallels Management Console application on your 
computer. 

 Context-sensitive help. When working in Parallels Management Console, you can open a 
help page for the currently active window by pressing F1 on your keyboard. 

 Online documentation. All documentation for Parallels Management Console and other 
Parallels products, such as Parallels Server Bare Metal and Parallels Server for Mac is also 
available online. 

 Parallels website (http://www.parallels.com/support/). Visit the Parallels Support web page 
containing product help files and the FAQ section. 

 Parallels Knowledge Base (http://kb.parallels.com/). This online resource comprises various 
articles about using Parallels Management Console and other Parallels products. 

 

http://www.parallels.com/support/
http://kb.parallels.com/
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Feedback 
If you spot a typo in this guide, or if you have an opinion about how to make this guide more 
helpful, you can share your comments and suggestions with us by completing the 
Documentation Feedback form on our website (http://www.parallels.com/en/support/usersdoc/). 

 

 
 

http://www.parallels.com/en/support/usersdoc/
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Getting Started With Parallels 
Management Console 

This chapter describes how to start working with Parallels Management Console. 

In This Chapter 
Starting Parallels Management Console ............................................................................... 11 
Exploring Parallels Management Console Interface ............................................................. 11 
Setting Up Parallels Management Console Preferences ....................................................... 19
 
 

Starting Parallels Management 
Console 

To launch Parallels Management Console: 

 On Mac OS X, open the Applications folder, and launch the Parallels Management 
Console application. 

 On Windows, choose All Programs > Parallels > Parallels Management Console > Parallels 
Management Console from the Start menu 

 On Linux, start Terminal, and execute pmc-standalone. 

Note: The version of Parallels Management Console shipped with Parallels Server 5 Bare Metal 
can be installed only on Windows and Linux computers. 
 

Exploring Parallels Management 
Console Interface 

This section describes the main components of Parallels Management Console. 
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Welcome Window 
When you start Parallels Management Console for the first time, the Parallels Management 
Console welcome window appears. In this window, you can do the following: 

 Connect to a Parallels physical server. To do this, click Connect to Parallels Server. 
 View the Parallels Management Console Getting Started Guide. To do this, click View 

Getting Started Guide. 
 Open the Parallels website in your default browser. To do this, click Parallels Website. 
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Parallels Management Console Overview 
When you launch Parallels Management Console, the following window appears: 
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The main Parallels Management Console parts are listed below. 

Menu 

This part contains options for administering Parallels Management Console, Parallels physical 
servers, and virtual machines. 

Toolbar 

This part comprises buttons for managing virtual machines. For detailed information on the 
toolbar, see Toolbar (p. 15). 

Sidebar 

This part contains the list of Parallels physical servers registered in Parallels Management 
Console and their virtual machines. If you right-click a server in the list, you see a set of 
commands for managing this server. If you right-click a virtual machine in the list, you see a set 
of commands for managing this virtual machine. 

Main Window 

This part shows the information related either to a Parallels server or to a virtual machine, 
depending on what you choose in the sidebar. The main window includes the following tabs: 

 The Summary tab displays the basic information about the selected Parallels server or virtual 
machine (its name, location, OS, state and description), the main operations you can 
perform on it, and the current configuration. For a Parallels server, the tab also shows the 
list of virtual machines hosted on the server. 

 The Console tab is available when the virtual machine is running and acts as the virtual 
machine display. 

 The Performance tab shows the CPU, memory, hard disk, and network usage by the selected 
Parallels server or virtual machine. 

 The Backup tab lists virtual machine backups. On this tab, you can also create a new 
backup, restore the virtual machine from its backup, and delete the backups you do not need 
any more. 

Status Bar 

This part displays the information about devices installed in the selected virtual machine. The 
status bar shows this information for running virtual machines only. For details about the status 
bar, see Status Bar. (p. 17) 
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Toolbar 
The toolbar contains buttons for most frequent commands you are likely to perform in Parallels 
Management Console: starting and stopping virtual machines, suspending and resuming them, 
and so on. 

Some toolbar buttons become enabled only when a virtual machine is running. If you click a 
toolbar button, it becomes visibly pressed. 
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The main toolbar buttons are listed below: 

 Start. Use this button to start a virtual machine if it is shut down, paused, or suspended. If 

the virtual machine is suspended or paused, this button becomes the Resume button . 

 Shut Down. Use this button to shut down a guest operating system gracefully. 

 Suspend. Use this button to put a virtual machine into the sleep mode for a certain period 
of time. If you need to restart the Parallels server, you can temporarily suspend your virtual 
machines and easily resume them after the restart. 

  Detach Console (Attach Console). Use this button to detach the virtual machine console to 
a new window or to attach it back to the main window. You may use this button to view a 
running virtual machine in a separate window. 

 Full Screen. Use this button to switch a virtual machine to the Full Screen mode (p. 71). 
To return back to the Window mode, press the default key combination Ctrl+Alt+Enter. You 
can change the default key combination in the Preferences dialog (p. 21) available from the File 
menu on a Windows and Linux computer or from the Management Console menu on a Mac 
computer). 

 Server Level. Use this button to quickly switch from the virtual machine window to the 
window of the server this virtual machine belongs to. 

 Restart. Use this button to restart a guest operating system. 

 Pause. Use this button to pause a virtual machine when you need to instantly release the 
server resources used by this virtual machine. 

 Stop. Use this button to stop a virtual machine when it is not running properly and cannot 
be stopped using a normal shutdown procedure. 

Note: If you click this button when a virtual machine is running, you may lose all unsaved 
data. To turn off the virtual machine, use the shutdown procedure for the guest OS installed 
in it or use the Shut Down button. 

 Reset. Use this button for the hard reset of a virtual machine when it is not running 
properly and cannot be restarted using the Restart button. 

 Take Snapshot. Use this button to create a snapshot of a virtual machine. 
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 Revert to Snapshot. Use this button to roll back the changes made to a virtual machine 
since the last snapshot. 

 Manage Snapshots. Use this button to open the Virtual Machine Snapshots manager. For 
more information on snapshots, see Working with Snapshots (p. 134). 
 

Customizing Toolbar 

To change the appearance of the toolbar, right-click the toolbar and choose one of the following 
options: 

 Icon & Text. Use this command to make the toolbar display both the icon buttons and names. 
 Icon Only. Use this command to make the toolbar display the icon buttons only. 
 Text Only. Use this command to make the toolbar display the name buttons only. 
 Use Small Size. Use this command to reduce the size of toolbar buttons. 
 Remove Item. Use this command to remove items from the toolbar. 
 Customize Toolbar. Use this command to open the toolbar settings pane. See the description 

below. 

To customize the set of toolbar buttons and its appearance, right-click the toolbar, and choose 
Customize Toolbar. The toolbar settings pane opens. In this pane, you can perform the following 
operations: 

 Add new buttons to the toolbar by dragging them from the settings pane to the toolbar. 
 Remove buttons from the toolbar by dragging them from the toolbar to the settings pane. 
 Add separators to the toolbar by dragging them from the settings pane to the toolbar. 
 Add spaces to the toolbar by dragging them from the settings pane to the toolbar. 
 Restore the default toolbar buttons set by dragging it to the toolbar. 
 select the toolbar buttons view mode in the Show list 

To apply the changes you have made to the toolbar settings pane, click Done. 
 

Status Bar 
When a virtual machine is running, the status bar of its window displays the information about 
devices connected to the virtual machine. 
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The following devices have icons in the status bar: 

 keyboard  

 floppy disk drive  

 CD/DVD-ROM  

 hard disk  

 network adapter  

 serial port  

 parallel port  

 sound card  

 USB controller  

 shared folders  

If you see the  icon in the status bar, it means that Parallels Tools are installed in your virtual 
machine. 

You can connect or disconnect some of the virtual machine devices at runtime by clicking their 
icons in the status bar and choosing the respective commands from the shortcut menu. The 
picture below shows the shortcut menu for the CD/DVD-ROM drive. 

 

To connect CD/DVD ISO images to the virtual machine's CD/DVD-ROM drive or connect 
floppy images to its floppy disk drive, drag the required image file over the CD/DVD-ROM 
drive icon or the floppy disk drive icon in the status bar. For more information, see Changing 
Configuration at Runtime (p. 73). 
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Parallels Management Console Tray Icon 
When working with Parallels Management Console installed on Windows- and Linux-based 
physical computers, you can use the Parallels Management Console tray icon to perform the 
following operations: 

 Manage running and paused virtual machines. For detailed information, see Managing 
Virtual Machines From the Tray (p. 133). 

 Bring the Parallels Management Console window to focus. To do this, double-click the tray 
icon or right-click it, and choose Show Main Window. 

 Quit Parallels Management Console. To do this, right-click the tray icon, and choose the 
corresponding item. 

The Parallels Management Console tray icon is available if you configure the closing main 
window settings (p. 20) as follows: 

 Choose Ask for Action from the Closing Main Window menu. Now if you close the Parallels 
Management Console main window, you are asked whether you want to exit the application, 
to hide the main window to the notification area, or to cancel the operation. If you choose to 
hide the main window, the tray icon appears in the notification area. 

 Choose Hide to Notification Area from the Closing Main Window menu. Now if you close the 
Parallels Management Console main window, the tray icon appears in the notification area. 

 

Setting Up Parallels Management 
Console Preferences 

You can configure the Parallels Management Console settings using the Preferences dialog. To 
open this dialog: 

  On Mac OS X, choose Preferences from the Management Console menu. 

  On Windows, choose Preferences from the File menu. 

  On Linux, choose Preferences from the File menu. 
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General Preferences 
In the General pane, you can set the Parallels Management Console general preferences. 

 

Closing Main Window 

  On a Windows or Linux computer, you can configure how the Parallels Management 
Console main window should act when you close it: 

 Exit Application. Choose this option to exit Parallels Management Console on closing the 
main window. If you have a detached window of a running virtual machine, it will remain 
open. 

 Hide to Notification Area. Choose this option to minimize the application and hide it to the 
notification area on closing the main window. For detailed information on managing virtual 
machines from the notification area, see Managing Virtual Machines From the Tray (p. 133). 

 Ask for Action. Choose this option to configure Parallels Management Console to ask you 
what to do on closing the main window. 

Reset Hidden Messages 

Some of the Parallels Management Console dialogs and warnings include the Do not show this 
message again option. If you select this option in a dialog or warning, the dialog or warning is 
not shown any more. Clicking the Reset Hidden Messages button resets all dialogs and warnings 
so that they start appearing again. 

Restore Defaults 

  On a Windows or Linux computer, you can use this button to restore the default settings 
for Parallels Management Console general preferences. 
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Keyboard Preferences 
In the Keyboard pane, you can set keyboard shortcuts for the following actions: 

 Full Screen Toggle. This action switches the virtual machine window from the Window 
mode to Full Screen, and vice versa. 

 Release Input. This action releases the keyboard and mouse input from the virtual machine 
window. 

 

Restore Defaults 

To restore the default settings, click Restore Defaults. 
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Proxy Server Preferences 
  On a Windows and Linux computer, you can use the Proxy Server pane to configure a 

number of proxy server-related settings. 

 

You can do the following: 

 Select the Do not use proxy server radio button if you do not want to use a proxy server for 
network connections. 

 Select the Use Internet Explorer proxy settings radio button to import the proxy sever 
settings from the connections settings of Internet Explorer. 

 Select the Use automatic configuration script radio button to automatically configure the 
proxy server settings. 

 Select the Specify a proxy server radio button to manually specify the proxy server settings. 
In this case, you need to provide the following information: 
a The IP address and port number of the proxy server. 

b If the proxy server requires authentication, select the Proxy server requires 
authentication option, and type the corresponding credentials in the User Name and 
Password fields. 

c If you want to use an SSL proxy server for secure connections, select the Use a different 
proxy server for SSL connections option. Click the SSL Proxy button and provide the 
server IP address and port number in the opened window. You can also specify the 
credentials for accessing the server, if required. 

Once you configured the proxy server settings, click OK to activate the changes. 
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Managing Parallels Servers 

This chapter describes operation you can perform on Parallels servers in Parallels Management 
Console. 

In This Chapter 
Registering a New Parallels Server....................................................................................... 23 
Activating a Parallels Server................................................................................................. 25 
Connecting to a Registered Parallels Server ......................................................................... 26 
Configuring Server Settings.................................................................................................. 27 
Disconnecting From a Parallels Server ................................................................................. 39 
Removing a Parallels Server ................................................................................................. 40
 
 

Registering a New Parallels Server 
To start managing Parallels servers and their virtual machines with Parallels Management 
Console, you need first to register these servers in Parallels Management Console. To register a 
Parallels server, do the following: 

1 Launch Parallels Management Console, and choose Add Server from the Server menu. If 
you start Parallels Management Console for the first time, you can click Connect to Parallels 
Server in the welcome window to connect to the server. 

The Parallels Server Login dialog appears. 
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2 In the Parallels Server Login dialog, specify the parameters to use for connecting to the 
server: 

 In the Server field, type the Parallels physical server IP address or hostname. You can 
click the More Options option and choose the server from the Server List table (for 
details, see below). 

Note: By default, Parallels servers listen for connections on port 64000. If the listening port 
number differs from the default one, type the number of the port right after the server IP 
address. For example, if a Parallels physical server uses port 64001 for connections, type 
127.0.0.1:64001 into the Server field. 

 In the User Name and Password fields, type root as the username and the password of 
this user on the server. 

 To remember your login and password, select the Save Password option. 

3 Expand the More Options section to see the list of servers available on the network and 
specify additional settings: 

 Server List. This table lists servers Parallels Management Console founnd on your 
network. Only those servers are displayed that can receive broadcast messages. 

 Connection Security. In this field, you can choose the security level to use for 
connections between Parallels Management Console and the server. 

 Use Data Compression. If you select this option, the data sent between Parallels 
Management Console and the Parallels server will be compressed. If you use low-speed 
connections, select this option to improve the data transfer speed. You can change this 
setting later in the Login pane (p. 28) of the Server Settings dialog. 

4 Click Add Server. 

After a while, the selected server appears in the Parallels Management Console sidebar (p. 13). 
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Activating a Parallels Server 
When you connect to a Parallels server that is not activated, the message 'Your copy of Parallels 
Server is not activated.'  appears. If the server is not activated, you can create new virtual 
machines and edit their configuration, but you cannot run these virtual machines and install 
guest operating systems in them. 

Note: Parallels Management Console does not require activation. 

To activate a Parallels server: 

1 Click Activate Product when you see the message 'Your copy of Parallels Server is not 
activated.'  or choose Activate Product from the Help menu. The Activate Product dialog 
appears. 

 

2 Fill out the following fields in this dialog: 

 Name. Enter your name (optional). 

 Organization. Enter the name of your organization (optional). 

 Activation Key. Enter the key for your Parallels product. 

3 Click OK. If the product key is correct, your copy is successfully activated. 
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Connecting to a Registered 
Parallels Server 

When you start Parallels Management Console, all registered Parallels servers appear as 
disconnected, except the server specified as the default server to connect to (p. 28). 

Note: Only one server can be set as the default server. 

To connect to a registered server: 

1 Launch Parallels Management Console, select the server you want to connect to in the 
sidebar, and choose Connect from the Server menu. 

2 In the Parallels Server Login dialog, specify your user name and password for the server. 

 

If you want Parallels Management Console to save your login and password for future uses, 
select the Save Password option. In this case, you do not need to specify your credentials 
each time you connect to the server. 

3 Click Connect. 
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Configuring Server Settings 
Using Parallels Management Console, you can configure the following server settings: 

 server name 
 default folder for storing virtual machine files 
 default login and password for connecting to the server 
 connection security level 
 default folder for storing virtual machine backups 
 amount of memory available in virtual machines 
 PCIe devices assignment 
 virtual networks 

You can change any of these settings in the Server Settings dialog. To open this dialog: 

1 Make sure that you are connected to the Parallels server as a use with administrative 
privileges. 

2 Select the server in the sidebar, and choose Edit Settings from the Server menu. 
 

Setting General Options 
You can configure the general options of a Parallels server in the General pane of the Server 
Settings dialog. To open this pane, select the server in the Parallels Management Console 
sidebar, and choose Edit Settings from the Server menu. 
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In the General pane, you can do the following: 

 In the Custom Name field, configure the server name. This name is displayed in the Parallels 
Management Console sidebar and used to uniquely identify the server among other 
registered servers. 

 In the Default Folder for Virtual Machines field, specify the default folder for storing virtual 
machine files. If you did not change this folder earlier, its path is set to one of the following: 

 in Parallels Server for Mac—/Users/Shared/Parallels/ 

in Parallels Server Bare Metal—/var/Parallels/ 

 in Parallels Server for Mac Bare Metal Edition—/var/Parallels/ 

Restore Defaults 

To restore the default settings, click Restore Defaults. 
 

Configuring Login Settings 
You can configure the login settings to use to connect to a Parallels server in the Login pane of 
the Server Settings dialog. To open this pane: 

1 Select the server in the Parallels Management Console sidebar. 

2 Choose Edit Settings from the Server menu. 

3 Click Login in the Server Settings dialog. 
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In the Login pane, you can configure the following settings:  

 The current user. Choose this option to connect to the server with the same user account that 
you used to log in to the primary operating system installed on this server. 

Note: This option is available for the localhost server only, which is the server with IP 
address 127.0.0.1 on your network. 

 This user. Enable this option and specify the user name and password to connect to this 
server. The name and the password you enter should be valid for the Parallels server. If you 
want to save the user name and password, select Save Password. 

 Connect to this server by default. Enable this option if you want to connect to this Parallels 
server automatically when you start Parallels Management Console. You can also set the 
level of security when connecting to the server. For more information about the security 
levels, refer to Security Options (p. 29). 

Note: You can set only one server as the default for the connection. 

 Use Data Compression. If you select this option, the data sent between Parallels 
Management Console and Parallels Server will be compressed. If you use low-speed 
connections, select this option to improve the data transfer speed. 

Restore Defaults 

To restore the default settings, click Restore Defaults. 
 

Defining Security Settings 
In the Security pane, you can set the level of security for incoming connections to the Parallels 
server. To open this pane: 

1 Select the server in the Parallels Management Console sidebar. 

2 Choose Edit Settings from the Server menu. 

3 Click Security in the Server Settings dialog. 
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The security level controls the encryption of data between the server and Parallels Management 
Condole. You can choose one of the following security levels: 

 High: All types of data transmitted between the Parallels server and Parallels Management 
Console are encrypted. This is the most secure level of encryption. Encrypting all data, 
however, may result in lower transmission rates. 

 Medium. All commands, events, and input data transmitted between the Parallels server and 
Parallels Management Console are encrypted, while video and device data is not encrypted. 
Encrypting only the most important data results in higher transmission rates as compared to 
the high security level. 

 Low. Data transmitted between the Parallels server and Parallels Management Console is 
not encrypted. This security level provides the fastest connection speed, but all data is 
unsecured and may be intercepted.  

After you have set the security level, restart the Parallels Server application to save the changes. 
To restart the application, you can use this command: 
# service parallels-server restart 

Restore Defaults 

To restore the default settings, click Restore Defaults. 
 

Configuring Backup Options 
In the Backup pane, you can configure the directory for storing virtual machine backups. To 
open this pane: 

1 Select the server in the Parallels Management Console sidebar. 

2 Choose Edit Settings from the Server menu. 

3 Click Backup in the Server Settings dialog. 
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You can choose one of the following options: 

 Local server. Select this option to store virtual machine backups on the Parallels server. By 
default, backups are stored in the following directories: 

 Parallels Server for Mac—/Users/Shared/Parallels/Backups 

 Parallels Server Bare Metal—/var/parallels/backups 

 Parallels Server for Mac Bare Metal Edition—/var/parallels/backups 

To change the default directory, specify the desired path in the field provided or click the 
Choose button and locate the directory. 

 Other server. Select this option to store virtual machine backups on a remote Parallels 
server—that is, on the server different from the one where the virtual machines are residing. 
To set a remote Parallels server as a backup server, type its IP address or hostname in the 
field provided, and specify the credentials to access the remote server in the User Name and 
Password fields. 

Restore Defaults 

To restore the default settings, click Restore Defaults. 
 

Settings Memory Options 
In the Memory pane, you can configure the maximum amount of memory (RAM) that can be 
allocated to the Parallels application and all running virtual machines on the server. To open this 
pane: 

1 Select the server in the Parallels Management Console sidebar. 

2 Choose Edit Settings from the Server menu. 

3 Click Memory in the Server Settings dialog. 
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By default, the amount of memory is adjusted automatically. However, you can manually set the 
memory limit the Parallels application and all running virtual machines are not allowed to 
exceed. To do this, select the Manually radio button and specify the required amount of memory. 

Notes:  

1. The specified amount of memory is shared between all virtual machines running on the 
server. 

2. For information on configuring the amount of RAM for individual virtual machines, see 
General Settings (p. 81). 

At any moment, you can restore the default settings by clicking Restore Defaults. 
 

Configuring Participation in the Parallels Customer Program 
In the Feedback pane, you can configure your participation in the Parallels Customer Experience 
Program (CEP). To open this pane: 

1 Select the server in the Parallels Management Console sidebar. 

2 Choose Edit Settings from the Server menu. 

3 Click Feedback in the Server Settings dialog. 
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If you participate in the program, Parallels collects information about your server and the 
configuration of your virtual machines. The gathered information is then used to make the 
product better fit your needs. The following information is collected: 

 hardware configuration of the server 
 software configuration of the server and virtual machines (the names and versions of the 

operating systems and software installed in them) 
 configuration files of virtual machines 

Private information like your name, e-mail, address, phone number, and keyboard input is not 
collected. 

For more details on the CEP, click the link at the bottom of the Feedback pane. 
 

Configuring PCIe Devices 
In the Intel VT-d pane, you can assign PCI Express (PCIe) devices installed on the Parallels 
server to virtual machines. This pane is available only if the Parallels server supports the Intel 
VT-d technology and the Intel VT-d support is enabled in BIOS. To open the pane: 

1 Select the server in the Parallels Management Console sidebar. 

2 Choose Edit Settings from the Server menu. 

3 Click Intel VT-d in the Server Settings dialog. 
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Once you open the Intel VT-d pane, you see a table listing all available PCIe devices on the 
server and their current assignments: 

Column Name Description 
PCI Devices PCIe device name. 

Assignment PCIe device assignment. A PCIe device can be assigned either to the 
Parallels server or to virtual machines. In the latter case, a special driver 
is installed on the server, which makes the PCIe device invisible for this 
server. 

Once the driver is installed, you can assign the device directly to a virtual 
machine. To configure a virtual machine to use the device, add it to the 
virtual machine configuration file. For more information, see Adding and 
Removing Devices (p. 117). 

At any time, you can configure the default settings by clicking Restore Defaults. 
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Managing Virtual Networks 
A virtual network acts as a binding interface between a virtual network adapter in a Container 
and a physical network adapter on the Parallels server. Using virtual networks, you can facilitate 
the process of managing your networks. For example, virtual networks can help you avoid 
problems when migrating virtual machines between Parallels servers. If you assign a virtual 
machine or Container virtual adapter directly to a physical adapter on the source server and 
migrate the virtual machine or Container to the destination server, the virtual adapter may get 
broken because the physical adapter on the destination server is different from that on the source 
server. To deal with such situations, you can create a virtual network on both servers, set the 
same name for both networks, and assign the virtual adapter to the virtual network on the source 
server. 

You can create the following types of virtual networks: 

 Host-only 
 Bridged 

Host-only virtual networks 

A Parallels sever can have several host-only virtual networks. A virtual machine connected to a 
host-only network can connect to the Parallels server and virtual machines connected to the 
same network. If you have, for example, two host-only virtual networks, the virtual machines 
connected to the first host-only network can connect to each other and to the Parallels server, 
but they cannot access the virtual machines on the second host-only network. 

For more information about host-only virtual networks, see Configuring Host-Only Network 
Settings (p. 36). 

Bridged virtual networks 

A Parallels server can have one or more bridged virtual networks. The number of bridged virtual 
networks cannot exceed the number of physical adapter installed on the Parallels server. A 
virtual machine connected to a bridged virtual network can connect to the network (local and/or 
Internet) where the physical adapter associated with this virtual network is joined. In a bridged 
network, a virtual machine is treated as a stand-alone computer on the network and can be 
configured in the same way as a real one. 

For more information about bridged virtual networks, see Configuring Bridged Network Settings 
(p. 38). 
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Configuring Host-Only Network Settings 

In the Host-Only pane, you can configure the settings of host-only virtual networks. To open this 
pane: 

1 Select the server in the Parallels Management Console sidebar. 

2 Choose Edit Settings from the Server menu. 

3 Expand the Virtual Networks item, and click Host-Only. Host-Only is the name of the default 
host-only virtual network on the Parallels server. If you have created other host-only virtual 
networks, click their names instead of Host-Only. 

 

You can do the following: 

 In the Type field, change the type of virtual network. 
 In the Name field, change the virtual network name. 
 In the Description field, change the virtual network description. 
 In the Network Adapter field, select the network adapter to connect to the virtual network. 

This field is available only if you change the network type to 'bridged' in the Type field. 
 Click the Advanced button to open the Advanced Network Settings dialog where you can 

configure a number of advanced network parameters for the virtual network. For more 
information on advanced settings, see Defining Host-Only Network Settings (p. 37). 

 Click the Reset button to restore the default settings. In this case, all custom networks are 
removed from the Parallels server, except for two default networks (Host-Only and 
Bridged), and the parameters of both networks are set to default values. 
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Defining Host-Only Network Advanced Settings 
Once you click the Advanced button in the pane of a host-only network, the Advanced Network 
Settings window appears. 

 

In this window, you can do the following: 

 Specify the host IP address and network mask in the Parallels adapter IP address and Subnet 
mask fields. 

 Select the Enable DHCP Server option to enable the Parallels DHCP server. This server 
automatically assigns IP addresses to the virtual machines connected to this host-only virtual 
network from the range you define in the Start address and End address fields. All IP 
addresses in the range must belong to the same subnet. 
If you do not want to use the Parallels DHCP server, clear the Enable DHCP Server option. In 
this case, you will need to set all IP parameters for virtual machines manually. 
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Configuring Bridged Network Settings 

In the Bridged pane, you can configure the settings of bridged virtual networks. To open this 
pane: 

1 Select the server in the Parallels Management Console sidebar. 

2 Choose Edit Settings from the Server menu. 

3 Expand the Virtual Networks item, and click Bridged. Bridged is the name of the default 
bridged virtual network on the Parallels server. If you have created other bridged virtual 
networks, click their names instead of Bridged. 

 

You can do the following: 

 In the Type field, change the type of virtual network. 
 In the Name field, change the virtual network name. 
 In the Description field, change the virtual network description. 
 In the Network Adapter field, select the network adapter to connect to the virtual network. 

This field is available only for bridged virtual networks. 
 Click the Reset button to restore the default settings. In this case, all custom networks are 

removed from the Parallels server, except for two default networks (Host-Only and 
Bridged), and the parameters of both networks are set to default values. 
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Adding a Virtual Network 

To create a new virtual network, do the following: 

1 In the Server Settings window, click the Add button  to open the New Virtual Network 
window. 

 

2 Select the virtual network type: 

 Select the Bridged Ethernet radio button to create a bridged network. In this case, you 
need to choose the network adapter to connect the bridged virtual network to from the 
Network Adapter menu. This menu lists all network adapters and Ethernet interfaces 
available on the Parallels server. 

 Select the Host-Only Network radio button to create a host-only network. 

3 Click OK. 
 

Disconnecting From a Parallels 
Server 

If you do not plan to work with a Parallels server during a certain time, you can temporarily 
disconnect Parallels Management Console from the server and free some resources on the local 
computer. To disconnect from a Parallels server: 

1 Select the server in the Parallels Management Console sidebar. 

2 Choose Disconnect from the Server menu. 
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Removing a Parallels Server 
To remove a Parallels sever from the list of registered servers in Parallels Management Console, 
do the following: 

1 Select it in the Parallels Management Console sidebar. 

2 Choose Remove from the Server menu. 
 



 
 

 

 

C H A P T E R  4  

Managing Virtual Machines 

This chapter provides information on the main day-to-day operations you are likely to perform 
on virtual machines. 
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Adding an Existing Virtual Machine .................................................................................... 64
 
 

Creating a New Virtual Machine 
The process of creating a new virtual machine includes the following basic steps: 

1 Creating a virtual machine configuration. 

2 Installing a guest operating system. To check the list of supported guest operating systems, 
check the user's guide for the respective Parallels product. 

3 Installing Parallels Tools. 

These steps are described in the following sections in detail. 
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Choosing Installation Mode 
Parallels Management Console offers several modes of creating virtual machine configurations 
and installing guest operating systems. So before starting to create your first virtual machine, 
make sure you know what each of the installation modes means. 

Express Installation 

In the Express installation mode, Parallels Management Console automatically creates a virtual 
machine configuration and installs the guest operating system (OS) you choose. This is the 
easiest way to create a new virtual machine. All you need to do is to provide guest OS 
installation files and specify the OS product key, if necessary, and Parallels Management 
Console will do the rest. For more information on this installation mode, see Creating Virtual 
Machines in Express Mode (p. 43). 

Typical Installation 

In the Typical installation mode, Parallels Management Console asks you to specify the type 
and version of the guest OS you want to run in your virtual machine and where you want to 
store the virtual machine files. Once you provide this information, Parallels Management 
Console creates a typical virtual machine configuration and starts the OS installation. You then 
follow standard instructions to install the operating system the same way you do this on a 
standalone computer. For more information on this installation mode, see Creating Virtual 
Machines in Typical Mode (p. 45). 

Custom Installation 

In the Custom installation mode, you manually specify all options and control the whole process 
of creating the virtual machine. In particular, you specify the amount of RAM for the virtual 
machine, the size and format of ts virtual hard disk, network parameters, and so on. The Custom 
installation mode is intended for experienced users. For more information on this mode, see 
Creating Virtual Machines in Custom Mode (p. 47). 
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Creating Virtual Machines in Express Mode 
Installation in the Express mode is supported for the following operating systems: 

 Windows 7 
 Windows Vista 
 Windows XP 
 Windows Server 2003 
 Windows 2000 Server 

To create a virtual machine in the Express installation mode, do the following: 

1 Start Parallels Management Console, and choose New from the File menu. This launches the 
New Virtual Machine wizard. 

2 In the Select Operating System Type and Version window, select the guest OS to install in the 
virtual machine, and click Next. 

3 In the Virtual Machine Type window, select Express Windows, and click Next. 
4 In the Name and Location window, define the name and location for the virtual machine: 

 Name. Indicate an arbitrary name for the virtual machine. By default, the virtual machine 
gets the same name as the operating system installed in it. If a virtual machine with such 
a name already exists, you are prompted to indicate another name. The name must not 
exceed 50 characters. 

 Location. Use the Choose button, if necessary, to change the default location of the 
virtual machine files. 
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Click Next. 
5 In the Express Windows Installation window: 

a Specify your personal information and enter the product key for your operating system. 

Note: If you do not specify the Windows product key in this step, you will have to provide 
it later when the Windows guest OS installation starts. 

b Select the 64-bit Windows version option if you are installing a 64-bit version of the 
guest operating system. 

c If necessary, click the Advanced button, and configure the number of CPUs and the 
amount of RAM for the virtual machine. 

d Click Create. 

6 Once the virtual machine is created, the Prepare to Install Operating System window appears. 
In this window, specify the source of installation files, and click Start. In the Express mode, 
the source installation files may be located on the Parallels server only. 

To specify the path to the source installation files, do one the following: 

 To use a CD or DVD inserted into a server's CD/DVD drive, choose this drive from the 
Source menu. 

 To use a CD or DVD disc image connected to the virtual machine's CD/DVD drive, 
click the Source menu, and use Choose an image file to locate the file. 

Note: OS installation CDs and DVDs are not included with your Parallels product. You 
must purchase an operating system separately. 
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Once you click Start, the new virtual machine is started and the guest operating system is 
installed in it. After the installation, Parallels Management Console automatically installs 
Parallels Tools in the virtual machine. 

Note: When installing the guest OS, Parallels Management Console creates an Administrator 
account with a blank password. So you need to set a password for this account once the 
installation is complete. For information on setting administrator passwords, see the 
documentation for your guest OS. 
 

Creating Virtual Machines in Typical Mode 
To create a typical virtual machine: 

1 Start Parallels Management Console, and choose New from the File menu. This launches the 
New Virtual Machine wizard. 

2 In the Select Operating System Type and Version window, select the operating system you 
are planning to install in the virtual machine, and click Next. 

3 In the Virtual Machine Type window, select Typical, and click Next. 
4 In the Name and Location window, define the name and location for your virtual machine: 

 Name. Indicate an arbitrary nam for the virtual machine. By default, the virtual machine 
gets the same name as the operating system you install in it. If a virtual machine with 
such a name already exists, you are prompted to indicate another name. The name must 
not exceed 50 characters. 

 Location. Use the Choose button, if necessary, to change the default location of the 
virtual machine files. 
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Click Next. 
5 Once the virtual machine is created, the Install Operating System window appears. In this 

window, specify the source of installation files: 

 Select the installation source in the Placement list. Choose Physical Server if your 
source installation files are located on the Parallels server or choose Client 
Computer if the source installation files are located on the physical computer where 
Parallels Management Console is installed. If Parallels Management Console is installed 
on the Parallels server, in the Placement list, you will be able to choose only Physical 
Server. 

 Specify the path to the source installation files. If you want to use a disc inserted into the 
computer's CD/DVD drive, choose this drive from the Source menu. If you want to use 
a CD/DVD disc image connected to the virtual machine's CD/DVD drive, click the 
Source menu and use Choose an image file to locate the file. 

Note: OS installation CDs and DVDs are not included with your Parallels product. You 
must purchase an operating system separately. 

 

 If you want to connect the installation source to the virtual machine in this step, make 
sure the Connect the installation media option is selected. If you clear this option and 
start the virtual machine or start it later, you will have to connect the installation source 
to the virtual machine manually. 

To start the virtual machine and guest OS installation, click Start. When the installation is 
complete, install Parallels Tools (p. 54) if they are available for the guest OS. If you do not 
want to start the virtual machine and install the guest OS, click Done. 

 



 
 

 Managing Virtual Machines 47 
 

Creating Virtual Machines in Custom Mode 
To create a custom virtual machine: 

1 Start Parallels Management Console, and choose New from the File menu. This launches the 
New Virtual Machine wizard. 

2 In the Select Operating System Type and Version window, select the guest OS you plan to 
install in the virtual machine, and click Next. 

3 In the Virtual Machine Type window, select Custom and click Next. 
4 In the Name and Location window, define the name and location for your virtual machine: 

 Name. Indicate an arbitrary name to be assigned to the virtual machine. By default, the 
virtual machine gets the same name as the operating system you install in it. If a virtual 
machine with such a name already exists, you are prompted to indicate another name. 
The name must not exceed 50 characters. 

 Location. Use the Choose button, if necessary, to change the default location of the 
virtual machine files. 
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Click Next. 
5 In the CPU and Memory Options window, specify the number of CPUs and the amount of 

RAM for the virtual machine, and click Next. You can use the slider or arrow buttons to set 
the value or simply type it into the corresponding field. 

 

6 In the Hard Disk Options window, select the type of virtual hard disk you want to use, and 
click Next. You can create a new hard disk image, use an existing one, or create a virtual 
machine without any hard disk at all. 
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7 The next step differs, depending on which option you choose In the previous step: 

 If you choose No hard disk, go to Step 8. 

 If you choose Existing image file, the Existing Virtual Hard Disk window appears. In this 
window, specify the hard disk image to connect, and click Next. 

 If you choose New image file, the Hard Disk Options window appears. In this window, 
specify the capacity and type of the virtual disk, and click Next. 

 



 
 

 Managing Virtual Machines 50 
 

8 In the Networking Type window, select the type of networking you want to use in the virtual 
machine, and click Next. 
 Virtual Network. If you select this option, the virtual machine will be connected to one of 

the virtual networks (p. 35) available on the Parallels server. 

 Routed Networking. If you select this option, the virtual machine will appear as a full 
member on the network, and its traffic is routed via one of the adapters installed on the 
Parallels server. 

 Direct Assignment (using Intel VT-d). This option is available only if a PCIe network 
adapter is installed on the Parallels server and the Intel VT-d technology is enabled on it. 
If you select this option, the virtual machine will be able to access the local network and 
Internet through the specified PCIe network adapter. 

 No Networking. If you select this option, the virtual machine will have no network 
adapter. 

Note: You can reconfigure the networking settings after creating the virtual machine. 

9 This step differs depending on the option you select in the previous step: 

 If you select the No Networking option, go to Step 10. 

 If you select the Direct Assignment (using Intel VT-d) option, the Network Adapter 
window appears. In this window, select the PCIe network adapter you want to use, and 
click Next. Notice that before using the PCIe adapter in the virtual machine, you need to 
assign it in the Intel VT-d pane (p. 33) of the Server Settings dialog and install the 
manufacturer's driver for this PCIe device. The driver must support the Intel VT-d 
technology. 

 If you select the Virtual Network option, the Network Adapter window appears. In this 
window, select the virtual network where to connect the virtual machine network, and 
click Next. 

10 In the Optimization Options window, select the optimization mode, and click Create. You 
can choose one of the following options: 

 Virtual machine (Recommended). Select this option to allocate most of the server 
resources to the virtual machine and its applications. 

 Host Computer. Select this option to allocate most of the resources to the server and its 
applications. 

11 Once the virtual machine is created, the Install Operating System window appears. In this 
window, specify the source of installation files: 

 Select the installation source in the Placement list. Choose Physical Server if your 
source installation files are located on the Parallels server or choose Client 
Computer if the source installation files are located on the physical computer where 
Parallels Management Console is installed. If Parallels Management Console is installed 
on the Parallels server, in the Placement list, you will be able to choose only Physical 
Server. 

 Specify the path to the source installation files. If you want to use a disc inserted into the 
computer's CD/DVD drive, choose this drive from the Source menu. If you want to use 
a CD/DVD disc image connected to the virtual machine's CD/DVD drive, click the 
Source menu and use Choose an image file to locate the file. 
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Note: OS installation CDs and DVDs are not included with your Parallels product. You 
must purchase an operating system separately. 

 

 To start the virtual machine and guest OS installation, click Start. When the installation 
is complete, install Parallels Tools (p. 54) if they are available for the guest OS. If you 
do not want to start the virtual machine and install the guest OS, click Done. 
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Installing a Guest Operating System 
You can install a guest operating system in a virtual machine from a CD or DVD, or from a 
CD/DVD image file. Some operating systems are available as CD/DVD disc images only. 

In some cases, the installation cannot be performed from a real CD/DVD disc because of disc 
reading problems. In such cases, it is recommended that you try to install the operating system 
from a CD/DVD disc image of this disc. ISO images of CD/DVD discs can be created using a 
third party imaging utility. 

You can also install the guest operating system using a PXE server via network. 

Some operating systems are installed only from floppy disks. If your computer does not have 
floppy drives, you can install such operating systems using images of installation diskettes or 
using real floppy disk drives inserted into an external USB floppy disk drive. You can create 
floppy disk images using third-party applications. 

Installing from a CD/DVD or its image 

To install a guest OS from a CD/DVD or using an image: 

1 Select the virtual machine, and make sure that it is stopped. 

2 Choose Configure from the Virtual Machine menu to open Virtual Machine Configuration. 

3 Open the CD/DVD-ROM settings, and configure the virtual CD/DVD-ROM drive settings. 

 If you are installing from a real CD/DVD, select the Real Device option and specify the 
real drive to connect in the CD/DVD-ROM list. Then insert the CD/DVD disc with the 
operating system files into the appropriate drive of the computer. 

 If you are installing from an image file, select the Image file option, and specify the path 
to the image file in the File field. 

Note: You can use ISO and DMG images for installing the guest operating system. CUE 
and CCD images may be also supported. 

4 Click OK in Virtual Machine Configuration to save the changes. 

5 Start your virtual machine by clicking Start . 

The installation will launch soon after the virtual machine is started. 

Note: If you need to press any keys inside the virtual machine during the guest OS installation, 
first click inside the virtual machine window to capture the keyboard and mouse input and than 
press the corresponding keys. To release the keyboard and mouse, press Ctrl+Alt. For more 
information, refer to Capturing and Releasing the Keyboard and the Mouse (p. 70). 

Installing from the network 
1 Choose Configure from the Virtual Machine menu to open Virtual Machine Configuration. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 
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3 Add a network adapter to your virtual machine configuration. 

4 Open the Boot Order pane in Virtual Machine Configuration and change the boot sequence 
to make the virtual network adapter the first device in the sequence. To do this, select 
Network Adapter in the list, and use the arrow buttons to move it to the top of the list. 

5 Click OK to apply the changes. 

6 Start the virtual machine by clicking Start  on the toolbar. 

Soon after your virtual machine is started, a list of available PXE servers will appear. 

During the installation, when the guest OS reboots for the first time, or after the installation, 
return the boot sequence to booting from the hard disk. 

Installing from a floppy disk image 
1 Select the virtual machine and make sure that it is stopped. 

2 To connect the installation medium, open Virtual Machine Configuration by: 

 right-clicking the machine and choosing Configure from the shortcut menu, or 

 choosing Configure from the Virtual Machine menu. 

3 Select the Floppy Disk pane in the sidebar and specify the path to the floppy image disk file 
in the Image File field. 

4 Click OK to apply the changes 

5 Start the virtual machine by clicking Start  on the toolbar. 

The installation will launch soon after the virtual machine is started. 

Reinstalling the guest OS 

The procedure of reinstalling the guest OS is the same as the procedure of installing the guest 
OS: provide the installation media or its image, connect it to the virtual machine, and start the 
virtual machine. The reinstallation will launch soon after the virtual machine is started. 

Note: You can reinstall the guest OS of the same type only. However, you are free to choose the 
guest OS version. 

Keep in mind that in some cases, it is easier just to create a new virtual machine, install the 
guest OS, and delete the old machine after moving all the necessary data to the new one. 
 



 
 

 Managing Virtual Machines 54 
 

Using Parallels Tools 
Parallels Tools are a suite of special utilities that help you use your virtual machines in the most 
comfortable and efficient way. With Parallels Tools, you can move the mouse seamlessly 
outside the guest OS window without pressing any key, change the virtual machine's screen 
resolution by simply resizing its window, synchronize your virtual machine's time and date 
settings with the time settings of the host computer, and share the host computer disks and 
folders with its virtual machines. 

Parallels Tools are located on the disc images that are installed along with Parallels Server Bare 
Metal or Parallels Server for Mac. There is a separate Parallels Tools disc image for each type 
of the supported guest operating systems. 

 prl-tools-win.iso - disc image with Parallels Tools for Windows guest operating 
systems. 

 prl-tools-lin.iso - disc image with Parallels Tools for Linux guest operating 
systems. 

 prl-tools-mac.iso - disc image with Parallels Tools for Mac OS X guest operating 
systems. 

Note: You can create virtual machines with Mac OS X guest operating systems only on 
Intel-based Macs. 

 prl-tools-other.iso - disc image with Parallels Tools for other guest operating 
systems. 

These disc images can be found in the following locations: 

 Parallels Server for Mac: /Library/Parallels/Tools/ 
 Parallels Server Bare Metal: /usr/share/parallels-server/tools/ 
 Parallels Server for Mac Bare Metal Edition: /usr/share/parallels-
server/tools/ 
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Supported Operating Systems 
Parallels Tools are available for the following guest operating systems: 

Windows 

 Windows 2000 
 Windows Server 2003 
 Windows XP 
 Windows Vista 
 Windows Server 2008 
 Windows 7 

Linux 

Any supported Linux guest operating systems that have the following packages installed: 

 X.org 6.7 and later 
 glibc2.4 and later 

Mac 

 Any supported Mac OS X guest operating systems. 

Note: You can create virtual machines with Mac OS X guest operating systems only on 
Intel-based Macs. 

 



 
 

 Managing Virtual Machines 56 
 

Installing Parallels Tools in a Windows Guest OS 
If you created your virtual machine using the Express Windows mode, Parallels Tools were 
installed automatically after the installation of the Windows guest operating system. 

If your virtual machine was created in the Typical or Custom mode, do the following to install 
Parallels Tools in it: 

1 Start the virtual machine and log in to the guest operating system. 

2 When the guest OS boots up, connect the Parallels Tools ISO image by choosing the Install 
Parallels Tools option from the Virtual Machine menu. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be 
installed in your guest operating system. To see the list of guest OSs supported by Parallels 
Tools, see Supported Operating Systems (p. 55). 

3 In the Welcome window, click Install. The wizard will start the automatic installation. 

4 When the installation is complete, click Reboot to exit the wizard and restart the virtual 
machine. 

Reinstalling Parallels Tools 

To reinstall Parallels Tools: 

1 Start the virtual machine. 

2 Choose Reinstall Parallels Tools from the Virtual Machine menu. 

The Reinstall Parallels Tools option is available only if Parallels Tools are up to date. If Parallels 
Tools are outdated, you will see the Update Parallels Tools option instead. See Updating Parallels 
Tools (p. 61) for details. 

How to check if Parallels Tools have been installed 

You can easily confirm whether Parallels Tools were installed. Start your virtual machine and 
look at the status bar of its window. If the tip "Press Ctrl + Alt to release the 
mouse and keyboard" appears in the status bar of the virtual machine's window, this 
means that Parallels Tools were not installed. When Parallels Tools are installed, you do not 
need to press any key to release the mouse and keyboard - they are released automatically. 
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Installing Parallels Tools in a Linux Guest OS 
Before installing Parallels Tools in a Linux guest OS, perform the following actions: 

 Close all applications in the guest operating system. 
 Disable the 3D accelerated window manager if you use any. 
 Make sure that you have the gcc package and kernel sources installed. If these packages are 

not installed, the Parallels Tools installer will warn you. The kernel sources package name 
depends on the type of Linux operating system you use: it can be kernel-devel, or 
kernel-headers, or something else. For more information about the kernel sources, 
refer to the Installing the GCC package and Kernel Sources in Linux (p. 154) section. 

Note: To install Parallels Tools in your virtual machine, you must have the root privileges.  

Installing Parallels Tools in the most recent versions of Linux guest OSs 

If you have one of the most recent versions of Linux OSs (Fedora 10) in your virtual machine, 
the prl-tools-lin.iso image file will be mounted automatically after you connect it to 
the CD/DVD-ROM drive. To install Parallels Tools, do the following: 

1 Start the virtual machine. 

2 When the guest OS boots up, click the Virtual Machine menu and choose Install Parallels 
Tools. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be 
installed in your guest operating system. To see the list of guest OSs supported by Parallels 
Tools, see Supported Operating Systems (p. 55). 

The prl-tools-lin.iso image file will be connected to the virtual machine's 
CD/DVD-ROM drive and mounted. 

3 Start a terminal in your Linux guest OS. Type the following command to gain the root 
privileges: 

su 

4 Change the directory to the CD/DVD-ROM directory using 
cd /media/cdrom/ 

Note: In some of the Linux operating systems, the mount point for the virtual CD/DVD-
ROM drive may appear as /media/Parallels\ Tools/. 

5 In the CD/DVD-ROM directory, enter the following command to launch Parallels Tools 
installation: 

./install 

6 Follow the Parallels Tools Installer instructions to complete the installation. 

7 When the installation of Parallels Tools is complete, restart your virtual machine. 

Installing Parallels Tools in other versions of Linux guest OSs 

To install Parallels Tools in the older versions of Linux OSs, you have to mount the prl-
tools-lin.iso image file manually. Do the following: 

1 Start the virtual machine. 
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2 When the guest OS boots up, click the Virtual Machine menu and choose Install Parallels 
Tools. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be 
installed in your guest operating system. To see the list of guest OSs supported by Parallels 
Tools, see Supported Operating Systems (p. 55). 

The prl-tools-lin.iso image file will be connected to the virtual machine's 
CD/DVD-ROM drive. 

3 Start a terminal in your Linux guest OS. Type the following command to gain the root 
privileges: 

su 

4 Check if the Parallels Tools CD image is mounted by entering 
mount | grep iso9660 

If this command does not return anything, proceed to the next step. 

If this command returns anything like 
/dev/cdrom on /media/cdrom type iso9660 (ro,exec,nosuid,nodev,uid=0), 

skip the next step and proceed to the following one. 

If this command returns anything like 
/dev/cdrom on /media/cdrom type iso9660 (ro,noexec,nosuid,nodev,uid=0) 

with the noexec option present in parentheses, you need to unmount the disc using the 
following command and then proceed to the next step: 

umount /dev/cdrom 

5 To mount the Parallels Tools installation disc image, enter the following: 
mount -o exec /dev/cdrom /media/cdrom 

Note: /dev/cdrom is the virtual machine's CD/DVD-ROM drive and /media/cdrom is 
the mount point for this device. In some of the Linux operating systems the virtual 
CD/DVD-ROM drive may appear as /dev/hdb and the mount point /mnt/cdrom. Some 
Linux OSs do not have the CD/DVD-ROM mount point. In this case, you should create the 
mount point directory manually. 

6 When the installation disc image is mounted, change the directory to the CD/DVD-ROM 
directory using 

cd /media/cdrom/ 

7 In the CD/DVD-ROM directory, enter the following to launch Parallels Tools installation: 
./install 

Note: You must have the root privileges to run this command. 

8 Follow the Parallels Tools Installer instructions to complete the installation. 

When the installation of Parallels Tools is complete, restart your virtual machine. 

Note: If X Server fails to start in your virtual machine, you can install Parallels Tools 
manually in text mode (p. 153). 

Reinstalling Parallels Tools 

To reinstall Parallels Tools, remove them (p. 63) first, and then install them again using the 
above procedure. 
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How to check if Parallels Tools have been installed 

You can easily confirm whether Parallels Tools were installed. Start your virtual machine and 
look at the status bar of its window. If the tip "Press Ctrl + Alt to release the 
mouse and keyboard" appears in the status bar of the virtual machine's window, this 
means that Parallels Tools were not installed. When Parallels Tools are installed, you do not 
need to press any key to release the mouse and keyboard - they are released automatically. 

Troubleshooting 

Parallels Tools installer can be blocked by SELinux. To solve this problem: 

1 Start a terminal and determine your version of kernel by entering 
uname -r 
2.6.18-8.el5 

2.6.18-8.el5 is the version of your kernel. 

2 Open the /boot/grub/grub.conf file or /boot/grub/menu.lst (depends on the 
version of your Linux operating system) and find the entry that corresponds to your version 
of kernel. 

title Red Hat Enterprise Linux Server (2.6.18-8.el5) 
 root (hd0,0) 
 kernel /vmlinuz-2.6.18-8.el5 ro root=/dev/VolGroup00/LogVol00 rhgb quiet 
 initrd /initrd-2.6.18-8.el5.img 

3 Type the following text at the end of the entry: 
selinux=0 

and the whole entry will be: 
kernel /vmlinuz-2.6.18-8.el5 ro root=/dev/VolGroup00/LogVol00 rhgb quiet 
selinux=0 

4 Save the file and restart the virtual machine. 

After the restart, mount the Parallels Tools disc image and try to install Parallels Tools. 
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Installing Parallels Tools in a Mac OS X Guest OS 
To install Parallels Tools in a Mac OS X guest OS: 

Note: You can create virtual machines with Mac OS X guest operating systems only on Intel-
based Macs. 

1 Start the virtual machine, and log in to the guest OS. 

2 When the guest OS boots up, connect and mount the Parallels Tools ISO image file by 
choosing the Install Parallels Tools option from the Virtual Machine menu. 

Note: If the Install Parallels Tools option is greyed out, make sure that Parallels Tools 
support your guest operating system. To view the list of guest OSs which are supported by 
Parallels Tools, see Supported Operating Systems (p. 55). 

3 Open the mounted image of the disk and double-click the Guest OS Tools For Mac OS X icon 
to start the installation. 

4 In the Welcome window, click Continue. 

5 In the Select a Destination window, specify the location for Parallels Tools. Click Continue. 

6 In the Standard Install on "Macintosh HD" window, if you need to set a different location for 
Parallels Tools, you can do it by clicking Change Install Location. Click Install to continue 
the installation. Type the password when prompted. 

In the Installation window, you can see the process of Parallels Tools being installed in your 
virtual machine. 

7 When the installation is complete, click Restart to exit the assistant and restart you virtual 
machine. 

Reinstalling Parallels Tools 

To reinstall Parallels Tools, remove them (p. 63) first, and then install them again using the 
above procedure. 

How to check if Parallels Tools have been installed 

You can easily confirm whether Parallels Tools were installed. Start your virtual machine and 
look at the status bar of its window. If the tip "Press Ctrl + Alt to release the 
mouse and keyboard" appears in the status bar of the virtual machine's window, this 
means that Parallels Tools were not installed. When Parallels Tools are installed, you do not 
need to press any key to release the mouse and keyboard - they are released automatically. 
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Updating Parallels Tools 
The procedure of updating Parallels Tools depends on the guest operating system they are 
installed in. 

In a Windows guest OS 

Parallels Management Console automatically checks for new Parallels Tools updates when you 
start your virtual machine. 

If a newer version of Parallels Tools is available, you will see the corresponding message 
offering you to update the tools. Click Install to update Parallels Tools. If you click nothing, 
updating will start automatically in a few seconds. 

If you do not want to update Parallels Tools or want to do it later, click Cancel. You will be able 
to update them later by using the Update Parallels Tools option from the Virtual Machine menu. 

Note: If you revert to a snapshot that was made when you had an earlier version of Parallels 
Tools in your virtual machine, you will also be offered to update them. 

If Parallels Tools are up to date but you want to reinstall them, choose the Reinstall Parallels 
Tools option from the Virtual Machine menu. 

In a Linux guest OS 

After you update the Parallels Server application, you should manually update Parallels Tools: 

Before updating Parallels Tools, perform the following actions: 

 Close all applications in the guest operating system. 
 Disable the 3D accelerated window manager if you use any. 

To update Parallels Tools: 

1 Start the virtual machine. 

2 When the guest OS boots up, choose Update Parallels Tools from the Virtual Machine menu. 
This will connect the prl-tools-lin.iso image to your virtual machine's CD/DVD-
ROM. 

3 Follow the steps (from Step 3) described in Installing Parallels Tools in a Linux Guest OS (p. 
57). However, when asked whether to upgrade or remove Parallels Tools, select Upgrade 
and click Next. 

In Mac OS X 

After you update the Parallels Server application, you should manually update Parallels Tools: 

1 Start the virtual machine. 

2 When the guest OS boots up, choose Update Parallels Tools from the Virtual Machine menu. 
This will connect the prl-tools-mac.iso image to your virtual machine's CD/DVD-
ROM. 



 
 

 Managing Virtual Machines 62 
 

3 Open the Parallels Tools CD-ROM mounted on the virtual machine's desktop and double-
click the Install icon. 

4 Specify your name and password when prompted. 

5 In the Welcome window, click Continue. 

6 In the Select a Destination window, specify where Parallels Tools will be installed and click 
Continue. 

7 In the Standard Install on "Macintosh HD" window, click Install. Specify your name and 
password when prompted. 

8 When the updating is complete, click Restart to quit the installer and restart your virtual 
machine. 
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Removing Parallels Tools 
Parallels Tools can be removed through a general procedure of removing applications from the 
operating system installed in your virtual machine. 

Removing from a Windows guest OS 
1 Start the virtual machine and log in to the guest OS. 

2 From the Windows Start menu, choose Control Panel > Add or Remove Programs. In 
Windows Vista, choose Control Panel > Programs and Features. In Windows 7, choose 
Control Panel > Programs > Programs and Features. 

3 Select Parallels Tools in the list and click Remove. 

4 When Parallels Tools are removed, restart the guest operating system. 

Removing from a Linux guest OS 

Perform the following actions before removing Parallels Tools: 

 Close all applications in the guest operating system. 
 Disable the 3D accelerated window manager if you use any. 

To remove Parallels Tools: 

1 Start the virtual machine. 

2 To remove Parallels Tools, you should connect and mount the prl-tools-lin.iso 
image and launch Parallels Tools Installer. For detailed instructions, see Installing Parallels 
Tools in a Linux Guest OS. 

3 Follow the Parallels Tools Installer instructions. When prompted to choose the action to 
perform, select Remove and press Enter. 

4 When Parallels Tools are successfully removed, press Enter to close the window. 

Removing from Mac OS X 
1 Start the virtual machine, and log in to the guest OS. 

2 To remove Parallels Tools, you should connect and mount the prl-tools-mac.iso 
image and launch Parallels Tools Installer. For detailed instructions, see Installing Parallels 
Tools in Mac OS X. 

3 Open the mounted image of the disc and double-click the Uninstall Parallels Tools icon to 
start the deinstallation. 

4 In the Welcome window, click Uninstall. Enter the password when prompted. 

5 In the Uninstallation window, you can see the process of Parallels Tools being removed from 
the virtual machine. 

6 In the Uninstallation Completed window, click Restart to finish the deinstallation and quit the 
assistant. 
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Adding an Existing Virtual Machine 
If you already have a virtual machine, but it is not registered in Parallels Management Console, 
you can register it using the Add Existing Virtual Machine wizard on a Windows or Linux 
computer or Add Existing Virtual Machine Assistant on a Mac computer. To register a virtual 
machine: 

1 Choose Add Existing from the File menu. 

2 In the Introduction window, click Next. If you do not want the Introduction window to appear 
in future, select Always skip introduction. 

3 In the Select a Virtual Machine window, locate the virtual machine you want to register: 

 You can set the path to a specific virtual machine's configuration file (config.pvs). 
Select the Add a specific virtual machine option, and type the path in the File field or 
click the Choose button and navigate to the necessary file. Click Add and go to Step 5. 

 You can find all virtual machines in a specific folder. Select the Search for virtual 
machines in this folder option, type the path to the necessary folder in the Start from field 
or click the Choose button, and navigate to it. Click Search. 
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4 If you choose Search for virtual machines in this folder, the wizard displays all unregistered 
virtual machines in the specified folder. Select the virtual machines you want to add. You 

can use the Select All  and Clear All  buttons at the bottom of the window to select 
and deselect all virtual machines at once. 

 

 

Review the selection, and click Add. 

5 Once the operation is complete, click Finish. 
 



 
 

 

 

C H A P T E R  5  

Working in a Virtual Machine 

This chapter explains how to start, stop, suspend or pause a virtual machine. It also provides the 
information on actions you can perform with the virtual machine while the guest operating 
system is running. 

In This Chapter 
Performing Main Operations on a Virtual Machine.............................................................. 66 
Using Keyboard and Mouse.................................................................................................. 70 
Changing the View Mode ..................................................................................................... 71 
Changing Configuration at Runtime ..................................................................................... 73 
Using Shared Folders ............................................................................................................ 75 
Making Guest OS Screenshots.............................................................................................. 77 
Assigning USB Devices to Virtual Machines ....................................................................... 78
 
 

Performing Main Operations on a 
Virtual Machine 

This sections describes day-to-day operations you are likely to perform with virtual machines. 
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Starting a Virtual Machine and Shutting It Down 
To start a virtual machine, do one of the following: 

 Click the Start button  in the toolbar (p. 15). 
 Choose Start from the Virtual Machine menu. 
 Right-click the virtual machine in the sidebar and choose Start from the shortcut menu. 
 Click Start in the Operations section of the virtual machine's Summary tab. 

After starting the virtual machine, it will boot into the guest operating system installed in this 
virtual machine. If no guest operating system is installed, you will see the following message: 
"No boot device is available...". 

Notes: 

1. The virtual machine can be powered on only if you activated the Parallels server, to which 
this virtual machine belongs. For details, refer to Activating a Parallels Physical Server (p. 25). 

2. It is not recommended that you start your virtual machines from an external storage device. 
This may result in low performance and unsteady operation. 

To shut down a virtual machine, do one of the following: 

 Click the Shut Down button  in the toolbar (p. 15). 
 Choose Shut Down from the Virtual Machine menu. 
 Right-click the virtual machine in the sidebar and choose Shut Down from the shortcut 

menu. 
 Click Shut Down in the Operations section of the virtual machine's Summary tab. 
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Suspending and Pausing a Virtual Machine 
Starting and shutting down virtual machines may take a considerable amount of time. Instead of 
performing these operations, you can suspend or pause a virtual machine for the required time 
and quickly resume it later. 

Note: Close the Virtual Machine Configuration dialog before changing the virtual machine state. 

Suspending a Virtual Machine 

Suspending a virtual machine is similar to putting a real computer into the sleep mode. When 
you suspend a virtual machine, you save its current state (including the state of all applications 
and processes running in the virtual machine) to a special file on the host computer. When the 
suspended virtual machine is resumed, it continues operating at the same point the virtual 
machine was at the time of its suspending. 

Suspending your virtual machine may prove efficient if you need to restart the host computer, 
but do not want to: 

 quit the applications running in the virtual machine 
 spend much time on shutting the guest operating system down and then starting it again 

To suspend a virtual machine, do one of the following: 

 Choose Suspend from the Virtual Machine menu. 

 Click the Suspend button  in the toolbar (p. 15). 

Note: You can view the configuration of the suspended virtual machine in the read-only mode. 
To be able to modify the suspended virtual machine configuration, you should stop the virtual 
machine. 

To resume a suspended virtual machine, click the Resume button  in the toolbar (p. 15) or 
choose Resume from the Virtual Machine menu. 

Pausing a Virtual Machine 

Pausing a virtual machine releases the resources, such as RAM and CPU, currently used by this 
virtual machine. The released resources can then be used by the Parallels server and its 
applications or by other virtual machines running on the Parallels server. 

Note: Only the amount of RAM used by the guest OS will be released. The memory used by the 
Parallels Server application will still be locked. 

To pause a virtual machine, do one of the following: 

 Click the Pause button  in the toolbar (p. 15). 
 Choose Pause from the Virtual Machine menu. 
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When a virtual machine is paused, its window is grayed out. To continue running the virtual 

machine, click the Resume button  in the toolbar (p. 15) or choose Resume from the Virtual 
Machine menu. 

Parallels Server is designed to operate like an ordinary computer application. This means that 
you do not have to change the virtual machine state from running to paused, suspended, or 
stopped before putting the Parallels server to sleep. In the sleep mode, the Parallels server does 
not allocate any resources to the running applications (including Parallels Server and all virtual 
machines) so that they are stopped automatically. As you start the Parallels server, all the 
applications are automatically up and running again. 
 

Stopping and Resetting a Virtual Machine 

Stopping a Virtual Machine 

If the guest operating system cannot be shut down correctly, you can forcibly stop the virtual 
machine by doing one of the following: 

 Click the Stop button  in the toolbar (p. 15); or 
 Choose Stop from the Virtual Machine menu. 

Warning: If you forcibly stop a virtual machine, you may lose all unsaved data. 

Resetting a Virtual Machine 

If some program error has caused your virtual machine to hang, you may wish to reset it. 

To reset a virtual machine, do one of the following: 

 Click the Reset button  in the toolbar (p. 15). If this button is absent from the toolbar, 
see Customizing Toolbar (p. 15). 

 Choose Reset from the Virtual Machine menu. 

Warning: If you reset a virtual machine, you may lose all unsaved data. 
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Using Keyboard and Mouse 

Capturing and Releasing the Keyboard and Mouse 
To start working in a virtual machine, you need first to capture the keyboard and mouse input in 
the virtual machine. To do this: 

1 Move the mouse pointer over the virtual machine window. 

2 Click in the window. 

When the keyboard and mouse input is captured in the virtual machine, you cannot move the 
pointer out of the virtual machine window and all keystrokes and button clicks go to the virtual 
machine. To release the keyboard and mouse back, press the hot key combination (Ctrl+Alt by 
default). The keyboard and mouse will be released immediately. 

Note: You can change the key combination for releasing the keyboard and mouse input using 
the Keyboard pane (p. 21) of the Preferences dialog (p. 19). 

If you want to automatically capture and release the keyboard and mouse input, you should 
install Parallels Tools in your virtual machine. After the Parallels Tools installation, you can 
capture and release the mouse and keyboard input more easily: 

 Click anywhere in the virtual machine window to capture the input; and 
 Click anywhere outside the virtual machine window to release the input. 

 

Keyboard Shortcuts in a Virtual Machine 
When working in a virtual machine, you can apply any of the main Windows and Linux 

shortcuts to your virtual machine with the help of the Keyboard icon  in the virtual machine 
status bar. Just click the icon and select the desired key combination from the drop-down list. 
The corresponding action will take place in the guest operating system. 
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Changing the View Mode 
Parallels Management Console provides a number of view modes to make your work with 
virtual machines more comfortable and efficient: 

 Window mode. This is the default view mode in which the virtual machine screen is 
displayed in the Parallels Management Console window. The window contains the 
following panes: 
 Summary. This pane provides basic information on the virtual machine and access to the 

Virtual Machine Configuration dialog. The Summary pane also contains buttons for the 
most frequent commands used to start, stop, and otherwise manage the virtual machine. 

 Console. In this pane, you can interact with the running virtual machine via its guest OS 
window. 

 Performance. In this pane, you can view the virtual machine CPU, memory, hard disk, 
and network usage when the virtual machine is running. 

 The Backup tab lists all virtual machine backups. It also contains the controls allowing 
you to create a new backup. 

 Full Screen mode. In this mode the virtual machine screen is expanded to occupy the whole 
of your physical computer screen. 

Switching to the Full Screen Mode 

You can run a guest operating system in the Full Screen mode when the guest operating system 
window occupies the whole screen and all controls are hidden. 

To switch to the Full Screen mode, do one of the following: 

 Click the Full Screen button  in the Parallels Management Console toolbar. 
 Choose Full Screen from the View menu. 

Note: The default hot key combinations can be configured in the Keyboard pane (p. 21) of 
the Preferences dialog (p. 19). 

To return to the Window mode, press the appropriate hot key combination (Ctrl+Alt+Enter by 
default). 

Detaching the Console Pane 

In this version of Parallels Management Console, you can detach the Console pane of your 
running virtual machine from the Parallels Management Console window and work with it in a 
separate window. 

To detach the Console pane, do one of the following: 

 Choose Detach Console from the View menu. 

 Click the Detach Console button  in the Parallels Management Console toolbar. 
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Note: If this button is missing from the toolbar, you can add it by customizing the toolbar 
(p. 17). 

If you want the Console pane to join the virtual machine window again, do one of the following: 

 choose Attach Console from the View menu 
 click the Attach Console button in the Parallels Management Console toolbar 
 close the separate Console window 

Locking the guest OS screen resolution 

The virtual machine screen resolution can be changed in the following situations: 

 When you adjust the guest OS display settings. 
 When you resize the virtual machine window (this feature works only when Parallels Tools 

(p. 54) are installed in your virtual machine). 
 When you run an application that automatically changes the screen resolution of your guest 

OS. 

This behavior of the virtual machine window can be irritating. To freeze the virtual machine 
screen resolution, use the Lock Window option available from the View menu. When the Lock 
Window option is enabled, the virtual machine screen resolution can be changed by adjusting the 
guest OS display settings only. 

Switching to the Coherence Mode 

The Coherence mode provides the highest level of integration between the host and the guest 
operating systems. In this mode, you can have any applications running under these operating 
systems on one desktop. For more information on the Coherence mode, see Working in the 
Coherence Mode. 

To switch a running virtual machine to operate in the Coherence mode, do one of the following: 

 Click the Coherence button  in the Parallels Management Console toolbar. 
 Select Coherence from the View menu. 

To exit Coherence, click the Parallels Management Console tray icon and choose Exit 
Coherence. 
 



 
 

 Working in a Virtual Machine 73 
 

Changing Configuration at Runtime 
Parallels Management Console allows you to connect or disconnect certain devices at runtime 
or switch some of them for using other media. 

Generally, the following virtual devices can be connected or disconnected at runtime: 

 SATA hard drives 
 CD/DVD-ROM drives 
 floppy disk drives 
 network adapters 
 printer ports 
 serial ports 
 sound devices 
 USB devices 
 shared folders 

You can configure any of these devices as follows: 

 Use the necessary command from the Devices menu in the menu bar. This menu is available 
only when the virtual machine is running. 

 Click a device icon on the status bar and choose the command from a device shortcut menu. 
The status bar displays the devices information when the virtual machine is running. 

 Drag an image file (*.iso or *.fdd) or a shared folder on the appropriate device icon in the 
status bar. This option is available only for CD/DVD-ROM drives, floppy drives and shared 
folders. 

Hard Drives 

To disconnect a SATA hard drive from a running virtual machine, choose Hard Disk 1 > 
Disconnect from the Devices menu. If you have several SATA drives connected to your virtual 
machine, they are marked as Hard Disk 1, Hard Disk 2, etc. and are listed in the order you added 
them to the virtual machine. 

To connect a disconnected disk, choose Hard Disk 1 > Connect to from the Device menu. 

CD/DVD-ROM or a Floppy Drives 

If you have several CD/DVD-ROM drives connected to your virtual machine, in the Devices 
menu they are listed in the same order as they were connected. The first CD/DVD-ROM drive 
will be CD/DVD-ROM 1, the second will be CD/DVD-ROM 2, and so on. 

Network Adapters 

You can connect the network adapter to any virtual network created on the Parallels server. If 
you have several network adapters used by the virtual machine, on the status bar and in the 
Devices menu they are listed in the same order as they were connected. The first network 
adapter will be Network Adapter 1, the second will be Network Adapter 2, and so on. 
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Printer Ports 

To connect or disconnect a printer port or to connect a printer or an output file to a printer port, 
do the following: 

 Click the Devices menu, select the corresponding printer port, and choose the appropriate 
command from the displayed menu. 

 Right-click the printer port icon  in the status bar to display the shortcut menu and 
choose the appropriate command. 

Serial Ports 

To connect or disconnect a serial port, do the following: 

 Click the Devices menu, select the corresponding serial port, and choose the appropriate 
command from the displayed menu. 

 Right-click the serial port icon  in the status bar to display the shortcut menu and choose 
the appropriate command. 

Sound Devices 

To connect or disconnect a sound device, choose the Activate or Mute options respectively. You 
can also choose the type of output and input devices. 

USB Devices 

Parallels Management Console automatically detects all USB devices plugged into the Parallels 
server. The devices that are currently connected to the virtual machine appear in the list from 
the Device menu. You cannot use a USB device in the Parallels server operating system while it 
is being used by the virtual machine. 

Shared Folders 

The Shared Folders options available at runtime are similar to the settings in the Virtual Machine 
Configuration dialog (p. 80). 

You can 

 share all disks of the Parallels server or Home Folder only with the virtual machine 
 add a new shared folder 

 



 
 

 Working in a Virtual Machine 75 
 

Using Shared Folders 
Shared folders are folders in the host computer operating system that are visible to the guest OS 
too. These folders can be used for exchanging files between the host computer operating system 
and a virtual machine or between several virtual machines. 

In the host computer operating system shared folders appear as usual folders, while in the guest 
OS they are objects of the network neighborhood. 

Using shared folders is possible for the supported Windows and Linux guest operating systems 
with Parallels Tools installed. 
 



 
 

 Working in a Virtual Machine 76 
 

Setting Up a Shared Folder 
Setting up a shared folder includes two steps: 

1 Installing Parallels Tools in the virtual machine. 

2 Adding shared folders to the virtual machine. 

Installing Parallels Tools 

To use shared folders, you first need to install Parallels Tools in the virtual machine. For more 
information on installing Parallels Tools, see Using Parallels Tools (p. 54). 

Adding a Shared Folder 

Once you install Parallels Tools, you can add shared folder to virtual machine: 

1 Open the Virtual Machine Configuration dialog by choosing Configure from the Virtual 
Machine menu. 

2 In the Virtual Machine Configuration dialog, select the Options tab, and click the Shared 
Folders pane (see Shared Folders Settings (p. 88)). 

3 Click the  button to open the Shared Folder Properties window. 

4 In the Shared Folder Properties window: 

a Make sure the Enabled option is selected. 

b In the Path field, type the path to the folder you want to share with the virtual machine. 
You can also click the Path field and use the Choose a folder button to locate the folder. 

c In the Name field, type the shared folder name under which the folder will be accessible 
from inside the virtual machine. 

d In the Description field, you can provide a brief description for the shared folder. 

e Select the Read-only option if you want the shared folder to have a read-only status 
when accessed from inside the virtual machine. 

f Click OK. 

 

5 Click OK in the Virtual Machine Configuration dialog to save the settings. 
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Viewing Shared Folders in Guest OS 
There are three ways to view the contents of the shared folders in the guest OS. 

Easy Way 1 

Click the Parallels Shared Folders icon on the desktop of the running guest OS and you will see 
all your shared folders. 

Easy Way 2 

If you select Map folders to drive letters in the Shared Folders pane of Virtual Machine 
Configuration, shared folders will be displayed as new disks with drive letters assigned every 
time you open up My Computer in the guest operating system. 

General Way 
1 In the virtual machine, open Windows Explorer. 
2 In Explorer, select My Networks Places, then select Entire Network, and find Parallels Shared 

Folders. 

3 Click Parallels Shared Folders to view the list of shared folders available in your virtual 
machine. 

Note: To be able to write to a shared folder inside a virtual machine, make sure that the Read 
Only check box for this folder is cleared in the Virtual Machine Configuration dialog. 
 

Making Guest OS Screenshots 
If you want to make a screenshot of the guest operating system when it is running, choose Make 
Screenshot from the View menu. The first screenshot file will be named Parallels 
Picture.png and placed on the desktop of the client computer. The next screenshots will 
have the same name with an appropriate number added. 
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Assigning USB Devices to Virtual 
Machines 

In Parallels Server Bare Metal, you can assign a USB device to a virtual machine so that the 
device is automatically connected to the virtual machine when you do the following: 

 Connect the USB device to the Parallels server. 
 Start the virtual machine. 

To assign a USB device to a virtual machine: 

1 In the Parallels Management Console left panel, select the server where the virtual machine 
you plan to use the USB device with is located, and choose Edit Settings from the Server 
menu. 

2 In the left pane of the Server Settings window, click USB. 
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3 Click the plus sign under the Permanent assignments table. 

 

4 Do the following: 

a In the USB Device column, choose the USB device you want to assign to the virtual 
machine. 

b In the Connect To column, choose the virtual machine where you want to connect the 
USB device. 

To add another assignment, click the plus sign once more. To delete an assignment, click the 
minus sign. 

5 Click OK. 

When assigning USB devices to virtual machines, keep in mind the following: 

 You cannot migrate a running virtual machine having one or more USB devices assigned. 
 After migrating a stopped virtual machine, all its assignments are lost. 
 All USB assignments are preserved if you restoring a virtual machine to its original location 

and are lost otherwise. 
 The association between a USB device and a virtual machine is created for the user 

currently logged in to the system. 
 



 
 

 

 

Editing Virtual Machine 

C H A P T E R  6  

Configuring Virtual Machines 

The Virtual Machine Configuration dialog allows you to edit the virtual machine settings and the 
devices it uses. This chapter provides instructions on how to use the Virtual Machine 
Configuration dialog. 

In This Chapter 
Editing Virtual Machine Configuration ................................................................................ 80 
Adding and Removing Devices ............................................................................................ 117
 
 

Configuration 
With the help of the Virtual Machine Configuration dialog, you can edit the settings of the virtual 
machine and the devices it uses. 

To open the Virtual Machine Configuration dialog, do one of the following: 

 Double-click the virtual machine icon in the sidebar of the Parallels Management Console 
main window. 

 Click Configure on the virtual machine Summary page. 
 Choose Configure from the Virtual Machine menu. 
 Right-click the virtual machine in the sidebar, and choose Configure. 
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The Virtual Machine Configuration dialog contains three tabs: 

figure the basic virtual machines settings: the virtual 
essors to be available to the virtual machine, and the 

 that the virtual machine can use. 
 settings related to the virtual machine 

o configure the current settings of the devices existing in the 
M drives, hard disk 

machine 

ral pane of the Virtual 
Machine Configuration dialog. 

 General. This tab allows you to con
machine name, the number of proc
amount of memory

 Options. This tab allows you to configure various
operation. For example, you can adjust the virtual machine startup and shutdown settings, 
edit the Parallels Tools parameters, or configure access rights to the virtual machine. 

 Hardware. This tab allows you t
virtual machine: processors, video cards, floppy disk and CD/DVD-RO
drives, network adapters, and so on. You can also add new devices to the virtual 
and delete existing ones. 

 

General Settings 
To view and edit the general settings of a virtual machine, use the Gene
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machine's name. It is displayed in 
ine's main window. 

 The guest OS type and version. This field, located right under the Name field, displays the 

 CPUs. In this menu, you can set the number of CPUs the virtual machine is allowed to use. 
The maximum number of virtual CPUs depends on the number of physical CPU cores 
installed on the Parallels server. For example, if you have a Core 2 Duo processor, you can 
assigns to the virtual machine no more than two virtual CPUs. However, in any case, you 
cannot set more than 16 virtual CPUs to a virtual machine. 

 Memory. In this field, you can set the amount of RAM that will be available to the virtual 
machine. You can choose any available value, but it is recommended that you set the value 
provided in the Recommended range below the slider. 

Enabling CPU Hotplug 

If a guest operating system supports the CPU hotplug functionality, you can enable this 
functionality for the virtual machine. Once the CPU hotplug functionality is turned on, you can 
configure the number of CPUs available to your virtual machines even if they are running. 
Currently, the following systems come with the CPU hotplug support: 

Linux 
 Linux operating systems based on the RHEL 5 kernel and higher (Red Hat Linux Enterprise 

5, CentOS 5, and so on) 
Windows 

 x64 version of Windows Server 2008 (Standard Edition) 
 x64 version of Windows Server 2008 (Enterprise Edition)  
 x64 version of Windows Server 2008 (Datacenter Edition)  
 x64 version of Windows Server 2008 R2 (Datacenter Edition) 

By default, the CPU-hotplug support is disabled for all newly created virtual machines. To 
enable this functionality, select the Enable CPU Hotplug option, and click OK. Once the CPU 
hotplug support is enabled, you can configure the number of CPUs for the virtual machine even 
if it is running. 

Enabling Memory Hotplug 

If a guest operating system supports the memory hotplug functionality, you can enable this 
functionality for the virtual machine. Once the memory hotplug functionality is turned on, you 
can configure the amount of memory available to your virtual machines even if they are 
running. Currently, the following systems come with the memory hotplug support: 

Linux (both x86 and x64 versions) 
 CentOS 5.3 and higher 
 Red Hat Enterprise LInux 5.3 and higher 
 Fedora 13 and higher 
 SUSE Linux Enterprise Server 10 and higher 
 Ubuntu 10.04 and higher 

Windows 

 Name. In this field, you can view and change the virtual 
the virtual mach

type and version of the guest operating system installed in the virtual machine or declared to 
be installed in future. 
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rver 2008 (Standard Edition) 

save the changes, click Cancel. 
 

Opti

Startup and Shutdown Settings 

 dialog. 

 x64 version of Windows Server 2008 R2 (Datacenter Edition) 
 x86 and x64 versions of Windows Se
 x86 and x64 versions of Windows Server 2008 (Enterprise Edition)  
 x86 and x64 versions of Windows Server 2008 (Datacenter Edition)  
 x86 and x64 versions of Windows Server 2003 (Enterprise Edition) 

By default, the memory hotplug support is disabled for all newly created virtual machines. To 
enable this functionality, select the Enable Memory Hotplug option, and click OK. Once the 
memory hotplug support is enabled, you can configure the amount of memory for the virtual 
machine even if it is running. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to 

ons 
This section describes the settings available on the Options tab of the virtual machine 
configuration window. 
 

To manage the virtual machine startup and shutdown settings, use the corresponding pane of the 
Virtual Machine Configuration
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e virtual machine will 

 used to connect to the 

Selecting actions to perform on powering on and off the host computer 

delay 
 time interval for the virtual machine. 

 host shutdown. Select the operation the virtual machine should do when you shut down 
Stop, Shutdown, Suspend. 

nt to save the changes, click Cancel. 

performance. 

Choosing the user account under which the virtual machine will run

From the Start as menu, you can choose the user account under which th
run. Choose between the following accounts: 

 Not specified. The virtual machine will run under the user account
Parallels server. 

 Administrator. The virtual machine will run under the administrator user account. 
 A specific user. The virtual machine will run under the specified user account. 

 On host startup. Select the operation the virtual machine should do when you start up the 
Parallels server: Do nothing, Start, or Restore previous state. You may use the Startup 
field to set the delay

 On
the Parallels server: 

When you finish, click OK to save the changes and quit the Virtual Machine Configuration 
dialog. If you do not wa
 

Optimization Settings 

In the Optimization pane of the Virtual Machine Configuration dialog, you can configure the 
settings related to the virtual machine 
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may slow down the productivity of your host 

elect this option to allocate more memory resources to the host computer 

 and quit the 
Cancel. 

ions pane of the Virtual Machine 

Optimizing Performance 
 Virtual machine. Select this option to allocate more physical computer memory resources to 

the virtual machine and its applications. Selecting this option may significantly increase the 
virtual machine performance. However, it 
computer applications. 

 Host computer. S
and its applications. 

When you finish configuring the hard disk settings, click OK to save the changes
Virtual Machine Configuration dialog. If you do not want to save the changes, click 
 

Permissions Settings 

To manage the virtual machine permissions, use the Permiss
Configuration dialog. 

 

Sharing the virtual machine with other users 

To specify other users' access rights for the virtual machine, choose one of the following from 
the Allow other users to menu: 

 No Access. If you select this option, other users will have no access to the virtual machine. 
 View. If you select this option, other users will be able to add this virtual machine to the 

virtual machines list and view its console. They will not be able to start, stop or otherwise 
control this virtual machine. 

 View and run. If you select this option, other users will be able to control the virtual machine 
and work in it. They will not be able to change the virtual machine configuration. 

 View, run and configure. If you select this option, other users will be able to perform any 
operations on the virtual machine and its files. 
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SmartGuard Settings 

In the SmartGuard pane of the Virtual Machine Configuration dialog, you can set up the automatic 
creation of snapshots. You can find detailed information on snapshots and how to work with 
them in the Working with snapshots section (p. 134). 

Note: You cannot create a snapshot manually or automatically or revert to a snapshot when 
your virtual machine is paused. 

The SmartGuard functionality allows you to back up your virtual machine automatically. 
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Enabled option at the top of the SmartGuard pane. 

Setting Time Interval 

ourly, 
daily and weekly snapshot. If the time interval is more than 24 hours, you will be able to restore 
the latest daily, weekly and monthly snapshot. 

To manage the snapshots and restore any of them, use Virtual Machine Snapshots (p. 136). 

Restricting Snapshots Number 

Use the Maximum number of snapshots to keep field to set the maximum number of snapshots 
that can be stored on the host computer. The maximum available value is 100 snapshots. As 
soon as Virtual Machine Snapshots reaches the limit for snapshots and needs to make a new one 
over the limit, it deletes the oldest snapshot. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
 

Remote Display Settings 

To enable the virtual machine display sharing, use the Remote Display pane of the Virtual 
Machine Configuration dialog. 

To enable SmartGuard, select the 

If you want to know when it is time to make the next snapshot and to be able to reject the 
snapshot creation, enable the Notify me before snapshot creation option. 

Set how often snapshots should be made in the Interval for taking a new snapshot field. You can 
set from one hour to 48 hours. 

If the time interval is less than 24 hours, SmartGuard will allow you to restore the latest h
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ou can set the TCP port for the virtual machine. VNC protocol uses ports 
 

You can share the virtual machine desktop using VNC protocol. 

To enable the virtual machine display sharing, select the Enabled option. 

 Host IP address. In this field, type the host computer IP address. 
 Port. In this field, y

5900 through 5906.
 Password. If you want to specify a password for viewing the virtual machine desktop, type 

it in this field. 

Note: If you start the virtual machine with the remote display disabled, you cannot change this 
option when the virtual machine is running. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 

 

olders with a virtual machine, they still reside and 

Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 

Shared Folders Settings 

To manage shared folders and their settings, use the Shared Folders pane of the Virtual Machine 
Configuration dialog. 

When you share the host computer disks or f
occupy space on the host computer hard disk. 
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d All disks options to 

 Metal. 

puter Home Folder 

Select the  option to specify the host computer folders to be shared with the 

Sharing Host Computer Disks to Virtual Machine 

Select the Share the host computer's folders with the virtual machine an
provide the virtual machine with access to: 

 all disks available on Macs running Parallels Server for Mac or physical computers running 
Parallels Server Bare

Sharing Host Com

Select the Home folder only option if you want to access the host computer Home folder from 
the virtual machine. 

Specifying Host Computer Folders to Be Shared 

User-defined folders
virtual machine. 

To add a folder, use the Add button . The Shared Folder Properties dialog will open. In this 
dialog, specify the following settings and click OK: 

 Enabled. Select this option to enable the shared folder. 

e folder. 
 Name. In this field, type the shared folder name that will appear in the virtual machine. 
 Description. In this field, you may type a brief description for this shared folder. 
 Read-only. Select this option if you want this shared folder to have a read-only status when 

accessed from the virtual machine. 

To remove a shared folder, select it and click the Remove button 

 Path. In this field, type the path to the folder you want to share with the virtual machine. 
You can use the Choose button to locate th

. 

For more information about shared folders, see Using Shared Folders (p. 75). 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
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In the Full Screen mode, the guest operating system 

 settings even when the virtual machine is running. 

Full Screen Settings 

In the Full Screen pane, you can configure the virtual machine's appearance and behavior when 
it is running in the Full Screen view mode. 
window occupies the whole screen. 

You can configure the Full Screen
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puter Screen Resolution to the Virtual Machine Resolution in Full 
Screen 

creen resolution if Parallels Tools installed are installed in 

 Remains the same if Parallels Tools are not installed in the virtual machine. 

In the second case, if the virtual machine screen resolution is lower than that of your physical 
computer, in the Full Screen mode, the virtual machine's screen will appear on a black 
background. If the virtual machine's screen resolution is higher than that of the host computer, 
in the Full Screen mode, the virtual machine's screen will have scroll bars. 

To adjust the screen resolution of the client computer to that of the virtual machine, select the 
Adjust your computer resolution in full screen option (Adjust Mac resolution in full screen on 
Mac). In this case, your computer will change its screen resolution each time the virtual 
machine is switched to the Full Screen mode. 

Using All Displays in Full Screen 

If you have multiple displays connected to the client computer, the guest operating system can 
use all these displays in the Full Screen mode. To enable this feature for the virtual machine, 
select Use all displays in full screen. Now if you change the view mode to Full Screen, your 
guest operating system will occupy all available displays. 
 

Advanced Settings 

The Advanced pane of the Virtual Machine Configuration dialog allows you to configure a 
number of advanced settings for a virtual machine. 

Adjusting the Client Com

When you switch the virtual machine to the Full Screen mode, its screen resolution: 

 Changes to the client computer s
the virtual machine. 
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tion enabled, Parallels Server Bare Metal automatically grabs the 
en you move it 

Off

All settings on this tab are related to Parallels Tools and,consequently, are applied only to the 
virtual machines that have Parallels Tools installed. 

SmartMouse 

The SmartMouse option allows the mouse to move smoothly between the virtual machine and 
your server. With this op
mouse input when you move the pointer to the virtual machine and releases it wh
back to the server. You can configure this option as follows: 

 Set the option to On. In this case, the mouse input is automatically captured in the virtual 
machine when you place the mouse pointer over it and released when you move it back to 
the server. 

 Set the option to . In this case, you need to click inside the virtual machine to capture the 
mouse input and press Ctrl+Alt to release it back to the server. 

Note: Ctrl+Alt is the default key combination. You can set another key combination for 
releasing the mouse in the server preferences (File > Preferences). 

 Set the option to Auto. In this case, the SmartMouse option is automatically turned off each 
pplication, or any other program that uses its own mouse 

Select the Synchronize time with the Parallels server option to have the virtual machine time 
nchronized with the time settings on the Parallels server. This option is 

d possible conflicts with third-party time synchronization tools, if you 

m that of the Parallels server, you 
can maintain this time difference by selecting Allow a different time than on the Parallels server. 

Copy & Paste 

If you want to copy and paste data between the server and the virtual machine, select the Share 
clipboard option. If the data you copy and paste is text and you want to preserve text formatting 
in the destination document, select the Preserve text formatting option. 

Updating Parallels Tools 

If you select the Allow automatic Parallels Tools updates option, Parallels Tools in the virtual 
machine is automatically updated once you update the Parallels Server Bare Metal software on 
the Parallels server. If you disable this option, you can manually check for available Parallels 
Tools updates and install them in the virtual machine by choosing the Update Parallels Tools 
option from the Virtual Machine menu. 
 

Hardware 
This section describes the settings available on the Hardware tab of the virtual m chine 
configuration window. 
 

time you run a game, graphic a
pointer instead of using the operating system pointer. The option is automatically turned on 
once you quit the game or application. 

Synchronizing Time 

settings automatically sy
disabled by default to avoi
use any in your virtual machine. 

If the time zone specified for the virtual machine differs fro

a
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The Resource pane of the virtual machine configuration window allows you to manage a 
- and disk-related parameters. 

Resource Settings 

number of CPU
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eters 

 is a positive integer number, which determines 
the minimal guaranteed share of the CPU the virtual machine or Container receives. The 
virtual machine or Container can consume more than the guaranteed value if no other 
Containers are competing for the CPU and the CPU Limit parameter is not defined. 
Parallels Server Bare Metal consider one 1 GHz CPU to be approximately equivalent to 50 
000 CPU units. 

 CPU Limit—CPU limit, in percent or megahertz (MHz). This is the CPU limit the virtual 
machine or Container may never exceed. The range of allowed values is displayed to the 
right of the CPU Limit field. 

Configuring Disk I/O Parameters 

You can also configure the bandwidth a virtual machine is allowed to use for its disk input and 
output (I/O) operations. Limiting the disk I/O bandwidth can help you prevent the situations 
when high disk activities in one virtual machine (generated, for example, by transferring huge 
amounts of data to/from the virtual machine) can slow down the performance of other virtual 
machines on the Parallels server. By default, the I/O bandwidth limit for all newly created 
virtual machines is set to 0, which means that no limits are applied to any virtual machine. To 
limit the disk I/O bandwidth for a virtual machine, set the desired limit, megabytes per second 
(MB/s), in the Disk I/O Limits field. 

Note: In the current version of Parallels Containers, the maximum I/O bandwidth limit you can 

Configuring CPU Param

On the Resource pane, you can configure two CPU-related parameters: 

 CPU Units—guaranteed CPU power. This

set for a Container is 2 GB per second. 

You can configure the disk input/output (I/O) priority level of a virtual machine. The higher the 
I/O priority level, the more time the virtual machine will get for its disk I/O activities as 
compared to the other virtual machines on the server. By default, any virtual machine has the 
I/O priority level set to 4. However, you can change the default priority level in the range from 0 
to 7 by specifying the necessary value in the Disk I/O Priority field. 
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der pane of the Virtual 

Boot Order Settings 

To set the boot sequence for your virtual machine, use the Boot Or
Machine Configuration dialog. 
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 starts, it can use one of these boot devices: 

Hard Disk

e if you want the virtual machine to boot up from the media 
connected to its CD/DVD-ROM drive. 

Note: The virtual machine will use the CD/DVD-ROM specified as CD/DVD-ROM 1 in the 

When the virtual machine

 . Select this device if you want the virtual machine to boot up from its virtual hard 
disk. 

 CD/DVD. Select this devic

virtual machine configuration. 

 Floppy Disk. Select this device if you want the virtual machine to boot up from the media 
connected to its floppy disk drive. 

 Network Adapter. Select this device if you want the virtual machine network adapter to use a 
PXE server for booting. 

Note: The virtual machine will use the network adapter specified as Network Adapter 1 in 
the virtual machine configuration. 

When the virtual machine starts up, it is trying to boot from the device that appears as the first 
device in this list. If the device has no media or it is not bootable, the virtual machine proceeds 
to the next device in the sequence, and so on. 

To change the booting sequence, select a device and move it using the arrows. 

To remove a device from the sequence, clear the check box next to its name. 

The Show advanced settings check box selected, you can enable the Select boot device on 
startup option. If you choose this option, you will see the following message at the virtual 
machine startup: "Press ESC to select boot device". If you press ESC pending 5 
seconds, you will be able to select a boot device. If you do not press ESC, the virtual machine 
will try to boot from the devices specified in the Boot order list. 

Note: Make sure that the device you wish to use for your virtual machine booting (hard disk 
drive, CD-ROM drive, floppy disk drive, or network adapter) is available to the virtual machine 
and configured properly. If you do not have any boot devices configured in your virtual 
machine, you will see the following error message after you start the virtual machine: “No 
boot device is available”. In this case, you should stop the virtual machine and 
configure at least one boot device for it. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
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Video Settings 

To set the amount of video memory available to the virtual machine video card, use the Video 
pane of the Virtual Machine Configuration dialog. 
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y field, you can set the amount of video memory that will be available to the 
u can specify any value from 2 to 256 MB; however, we recommend that 

The Maximum screen resolution field shows the maximum screen resolution that will be 
supported in the virtual machine with the specified amount of video memory. 

To configure the video memory limit, do one of the following: 

 drag the slider 
 use the spin box arrows 
 type the value directly into the Video memory field 

Keeping the Virtual Machine's Screen Resolution in Full Screen Mode 

When you switch the virtual machine to the Full Screen mode (p. 71), its screen resolution: 

 changes to the client computer screen resolution if you have Parallels Tools installed 

Note: If dynamic resolution does not work when switching to Full Screen mode in virtual 

In the Video memor
virtual machine. Yo
you choose the value from the range given in the Recommended size field below the slider. This 
will provide the most optimal performance for your virtual machine and the physical computer 
where this virtual machine is hosted. 

machines with Linux guest operating system installed, increase the amount of video 
memory available to the virtual machine's video card up to 16 MB. 

 remains the same. 

To always keep the virtual machine's screen resolution in the Full Screen mode, select the Keep 
the virtual machine's screen resolution in full screen option. With this option selected, if the 
virtual machine's screen resolution is, for example, 1280x1024 in the Window mode, it will also 
be 1280x1024 in the Full Screen mode. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
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Floppy Disk Settings 

To view and edit the virtual machine floppy disk drive settings, use the Floppy Disk pane of the 
Virtual Machine Configuration dialog. 

 

Enabled. Select this option to enable floppy disk drive operations in the virtual machine. To 

d or cleared only when the virtual machine is stopped. 

temporary disable floppy drive operations without removing the floppy drive from the virtual 
machine configuration, clear this option. 

Note: The Enabled option can be selecte

Connected. Select this option if you want the floppy disk drive or floppy disk image to be 
automatically connected to the virtual machine on its startup. 

You can choose one of the following devices to emulate the virtual machine floppy disk drive: 

 To use a real floppy disk drive, select Real Device and specify the device to use. 
 To use a floppy disk image, select Image File and specify the path to the floppy disk image 

file in the File field. You can also use the Choose button to locate the file. 

If you want to create a new floppy disk image or to replace the currently used floppy disk image 
by a blank floppy disk image, click the Recreate button. 

Warning: Recreating the current floppy disk image deletes all the data stored on this disk 
image. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
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g. Virtual CD/DVD-ROM drives can be connected either 
to physical CD/DVD-ROM drives or to CD/DVD images. The real device and the image file 
can belong both to the host and the client computers. 

Note: You can connect up to 4 IDE devices, 6 SATA devices, and 15 SCSI devices to a virtual 

CD/DVD-ROM Settings

To configure the virtual machine CD/DVD-ROM drive settings, use the CD/DVD-ROM pane of 
the Virtual Machine Configuration dialo

machine. Each device (hard disk or CD/DVD drive) is listed separately in the Virtual Machine 
Configuration dialog and has its own number. 
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ou want the virtual machine to use this CD/DVD-ROM drive. To 
ns with the CD/DVD-ROM drive without removing it from the 

Select the Enabled option if y
temporarily disable operatio
virtual machine configuration, clear the Enabled check box. 

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped. 

Select the Connected option if you want the CD/DVD-ROM drive to be automatically 

-ROM image file to the virtual machine. 

Note: Parallels virtual machines support ISO and DMG image files and may support CUE and 

connected to the virtual machine on its startup.  

To emulate the virtual CD/DVD-ROM drive, you can connect one of the real CD/DVD-ROM 
drives on your physical computer or a CD/DVD

CCD image files. 

Connecting Real Device 

To use a real device as the virtual machine CD/DVD-ROM drive: 

1 Select the Real Device option. 

2 Select the computer that hosts the device from the Placement list. 

 Host Computer. Select this option if you want to use the real device located on the host 
computer. 

 Client Computer. Select this option if you want to use the real device located on the 
client computer. 

3 Specify the device to connect by choosing it from the CD/DVD-ROM list. 

4 Select the Show advanced settings option if it is not selected and choose the type of interface 
to connect the device. Two types are available: 

 IDE. Using this interface type, you can connect up to four virtual devices (hard disks or 
CD/DVD drives). 

 SCSI. Using this interface type, you can connect up to seven virtual devices (hard disks 
or CD/DVD drives). 

Note: Red Hat Linux Enterprise 5 guest OS does not support the SCSI controller. 

5 Select the device position in the Location list. 

6 Select the Passthrough option to connect your real CD/DVD-ROM drive to the virtual 
machine in the passthrough mode. In this mode, the CD/DVD-ROM drive is directly 
assigned to the virtual machine. If you connect a recordable optical drive to a virtual 
machine in the passthrough mode, you will be able to use it to burn CD or DVD discs in the 
virtual machine. 

Note: If you select the Passthrough option, the physical computer will have no access to this 
CD/DVD-ROM drive. 

7 Click OK to apply the settings and close the Virtual Machine Configuration dialog. 

Note: The Interface, Location, and Passthrough options are available only if the Show advanced 
settings check box is selected at the bottom of the Virtual Machine Configuration dialog. 
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rive: 

2 Select the computer that hosts the image file from the Placement list. 

4 Select the Show advanced settings option if it is not selected and choose the type of interface 
le. Two types are available: 

pe, you can connect up to four virtual devices (hard disks or 

ype, you can connect up to seven virtual devices (hard disks 

Connecting Image File 

To use an image file as the virtual machine CD/DVD-ROM d

1 Select the Image File option. 

 Host Computer. Select this option if you want to use the image file located on the host 
computer. 

 Client Computer. Select this option if you want to use the image file located on the client 
computer. 

3 Type the path to the image file in the File field. You may use the Choose button to locate the 
file. 

to connect the image fi

 IDE. Using this interface ty
CD/DVD drives). 

 SCSI. Using this interface t
or CD/DVD drives). 

Note: Red Hat Linux Enterprise 5 guest OS does not support the SCSI controller. 

5 Select the position in the Location list. 

-ROM icon in the 
tus bar and choose 

6 Click OK to apply the settings and close the Virtual Machine Configuration dialog. 

You can also connect an image file using the Device menu or the CD/DVD
status bar. To connect an image, select the CD/DVD-ROM icon in the sta
Connect Image. 
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ard Disk pane of the Virtual 
rd disk images have the .hdd format. 

Hard Disk Settings 

To view and configure the settings of a virtual disk, use the H
Machine Configuration dialog. Ha
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necting disks 

om the virtual machine 
configuration, clear the Connected check box. 

Specifying the source file for disks 

To use a hard disk image file as a virtual hard disk: 

1 Choose the desired file from the Source menu, or click the Choose an image file link and 
navigate to the file. 

2 In the Location list box, choose the disk interface type and location: 

 IDE. Using this interface type, you can connect up to four virtual devices (hard disks or 
CD/DVD-ROM drives) to the virtual machine. 

 SCSI. Using this interface type, you can connect up to 15 virtual devices to the virtual 
machine. 

 SATA. Using this interface type, you can connect up to 6 virtual devices to the virtual 
machine. 

Notes:  

Connecting and discon

Select the Connected option if you want the virtual machine to use this hard disk drive. To 
temporarily disable operations with the hard disk without removing it fr

1. SATA disks can be added to and removed from running and stopped virtual m chines 
while operations on IDE and SCSI disks are allowed for stopped virtual machines only. 

2. The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI 
controller itself. 

a

3 Click OK. 

Resizing virtual hard disks 

To reduce or increase the virtual hard disk size, use the Edit button. If you click this button, the 
Resize Hard Disk window is displayed. 
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 can do one of the following: To reduce the virtual hard disk size, you

Note: Reducing dynamic disks is not supported. 

 If the virtual hard disk image is blank, specify the new size and click OK. 
 If the virtual hard disk already has a file system, specify the new size, select Resize file 

 of the following: 

l be unallocated. You will have to create a logical drive or a 
drive or partition. 

 to format the added space and it will be 

namic, specify the new size and click OK. You will have to 

easing the dynamic virtual hard disk size, make sure the Resize file system 

system, and click OK. 

To increase the virtual hard disk size, you can do one

 If the virtual hard disk image is blank, specify the new size and click OK. 
 If the virtual hard disk already has a file system, specify the new size and click OK. In this 

case, the added space wil
partition on the unallocated space and then format the newly created 

 If the virtual hard disk already has a file system, specify the new size, select Resize file 
system, and click OK. In this case, you will not have
available to the existent drive. 

 If the virtual hard disk is dy
format the newly added space manually. 

Note: When incr
option is not selected. 

Com

If y
phy creases as you add new data to the virtual disk. When you delete some data 

al hard disk, free unused space appears on the disk, but the amount of space the 
e occupies on the hard disk of the Parallels server does not reduce. To free the 

k the Compress button. 

pressing disks 

ou use an expanding virtual hard disk in your virtual machine, its image file size on the 
sical hard disk in

from this virtu
virtual machin
unused space on the physical server, clic

Note: Compressing is available only for Windows- and Linux-based virtual machines that have 
Parallels Tools installed and does not have any snapshots. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
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This section lists the types of disks that can be used by Parallels virtual machines and provides 
n perform with these disks. 

se virtual hard disks as their hard disks. 

e in 

 image file has a fixed size. The size is determined when the disk 

e file is stored on the Parallels server and is small 
initially. Its size grows as you add applications and data to the virtual h

Split disks 

r format can be a single-piece disk or a split disk. A split disk is cut into 2 

D/DVD discs. 

Floppy Disks and Floppy Disk Images 

Parallels virtual machines can use two types of floppy disks: 

 Real diskettes inserted into a real floppy disk drive that is connected to the virtual machine. 
 Floppy disk image files with the .fdd extension connected to the virtual machine. 

Floppy disk images are treated like real diskettes. Virtual machines support floppy disk image 
files that have .fdd extension and 1.44 MB size. 

Note: Parallels Management Console cannot create images of real diskettes. 

Support for Virtual and Real Disks 

the information about basic operations that you ca

Supported Types of Hard Disks 

Parallels virtual machines u

Virtual Hard Disks 

The capacity of a virtual hard disk can be set from 100 MB and up to 2 TB. 

Virtual hard disks can be either plain or expanding. When you create a virtual machin
Express Windows or Express Linux, or Typical mode (in New Virtual Machine Wizard (p. 42)), 
the disk is created in the expanding format. 

plain A plain virtual hard disk
is created.  

expanding An expanding virtual hard disk imag
ard disk in the 

guest OS. 

A virtual disk of eithe
GB pieces and is stored as a single .hdd file. 

CD/DVD Discs and Their Images 

A virtual machine can access real CD/DVD discs and images of C

There are no limitations on using multisession CD/DVD discs. Virtual machines can play back 
audio CDs without any limitations on copy-protected discs. 

Parallels virtual machines support CD/DVD disc images in the ISO and DMG formats. They 
may also support CD/DVD disc images in the CUE and CCD formats. 
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anage the virtual 
machine network settings. 

Network Adapter Settings 

The Networkr pane of the Virtual Machine Configuration dialog allows you to m
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he following settings: 

Connect

l network to connect the network adapter to. For more information 
on virtual networks, see Managing Virtual Networks. 

 Mac address. Change the MAC address assigned to the virtual network adapter. MAC 
addresses are automatically generated when you create a virtual machine. However, you can 
modify the default MAC address by typing another value in the MAC address field or 
clicking the Generate button. When specifying a new MAC address manually, make sure 
that it is unique within your network. 

Configuring Advanced Network Settings 

To configure a number of additional network settings for the virtual network adapter, click the 
Advanced Settings button. 

On this pane, you can configure t

 ed. Select this option if you want the virtual machine to start up with this network 
adapter connected. 

 Type. Choose the virtua
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managing the settings of your network 

e and Parallels command-line utilities. 

e Metal) supports using both IPv4 and 

 Subnet Mask/Prefix Length. Indicate the subnet mask for the network adapter. 
 for the network adapter. 

 a search domain for the network adapter. 

Once you are ready, click OK to save the changes; otherwise, click Cancel. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
 

Parallel Port Settings 

In the Parallel Port pane of the Virtual Machine Configuration dialog, you can configure the 
virtual machine parallel port settings. A virtual machine can have up to three parallel ports. 

In the Configure IP field, you can choose the way of 
adapter. Choosing From guest OS allows you to configure the adapter settings from inside the 
virtual machine. Choosing Manually allows you to configure the adapter settings using Parallels 
tools: Parallels Management Consol

If your system (for example, in Parallels Server 5 Bar
IPv6 addresses, you can click the desired tab and configure the following settings: 

 Enable DHCP. Select this option to set the adapter to receive its network settings (IP address, 
subnet mask, and default gateway) from a DHCP server. 

 Address. Specify the IP address to assign to the network adapter. 

 Default Gateway. Set the default gateway
 DNS Server. Specify a DNS server for the network adapter. 
 Search Domain. Specify
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Note: The Enabled option can be selected or cleared only when the virtual machine is stopped. 

Enabled. Select this option if you want to enable this parallel port in the virtual machine. To 
temporarily disable the parallel port without deleting it from the virtual machine configuration, 
clear this option. 

Connected. Select this option if you want the virtual machine to start up with the parallel port 

s to the virtual 

al machine parallel port. In this 
t. 

cript is installed in 
Windows virtual machines, irrespective of the real printer model and version. In most cases, 

 Output File. Select this option to emulate the parallel port by using an output file. In this 
with the default name will be created in the virtual machine folder. 

The path to the output file will be displayed in the File field. If you want to use another 

t the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
 

connected. 

A parallel port can be emulated by one of the following devices: 

 Real Port. Select this option to connect one of the host computer parallel port
machine parallel port. In this case, you will need to specify the appropriate physical port in 
the Parallel port field. 

 Printer. Select this option to connect a printer using the virtu
case, you will need to select the appropriate printer in the Printer lis
By default, the HP Color LaserJet 8500 PS printer supporting PostS

modern printers support PostScript and that is why you should disregard the printer name 
you see in the Windows printing wizard and complete the procedure. 

case, a new output file 

output file, type the full path to it in the File field or use the Choose button to locate the file. 

When you finish configuring the hard disk settings, click OK to save the changes and qui
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ane, you can configure the virtual machine serial port settings. 

 two virtual machines located on the same host computer (using a socket). 

er device, you should create a 
rises the devices on the host 

from the virtual machine. To do that, use the virtual machine status 

emu
The
wor
pan

r the 
 refer to Adding Serial Port. 

Note: You can connect up to four serial ports to a virtual machine. 

Serial Port Settings 

In the Serial Port p

Using serial ports, you can establish a connection between 

 the virtual machine and the host computer devices (using a real port) or 
 between

If you want to connect your virtual machine to the host comput
serial port emulated by a real port. The Serial Port list comp
computer that are available for connection. The connected device, being used in any virtual 
machine, cannot be used by the host computer. To be able to use it in the host computer, you 
should first disconnect it 
bar. 

If you want to connect two virtual machines with each other, you need to create a serial port 
lated by a socket in each virtual machine. The names of the serial ports should be identical. 
 connection between the virtual machines via serial ports is bidirectional. It means that the 
king modes of the sockets set during the port creation can be changed later in the Serial Port 
e. 

If you need to log the performance activity of your virtual machine or to record the data from it 
and use this information later on, you can connect your virtual machine serial port to an output 
file on the physical server. You will be able to view and analyze the activity history of the 
virtual machine any time you need it by exploring this file. 

You can add a new serial port to your virtual machine using Add Hardware Wizard. Fo
instruction on how to create serial ports,
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on if you want to enable this serial port in the virtual machine. To 
erial port without deleting it from the virtual machine configuration, 

hen the virtual machine is stopped. 

Enabled. Select this opti
temporarily disable the s
clear this option. 

Note: The Enabled option can be selected or cleared only w

Connected. Select this option if you want the virtual machine to start up with the serial port 

et. Select this option to connect two virtual machines through the sockets. When 

Note: If you change the socket mode of the first virtual machine, make sure that the socket 

connected. 

Serial ports can be emulated by the following devices: 

 Real Port. Select this option to connect the virtual machine serial port to one of the existing 
serial ports on the host computer. In this case, you will need to choose the appropriate port 
on the host computer in the Serial port list. 

 Sock
connecting the virtual machine to a socket, you can use the default path to the socket or type 
a new one in the Socket field. You can also configure the role the virtual machine will play 
in the connection by selecting the necessary role in the Mode list. Selecting Server enables 
you to use this virtual machine to direct the other one. Selecting Client enables you to direct 
this virtual machine from the other one. 

mode of the second virtual machine is also modified. 

 Output File. Select this option to connect the virtual machine serial port to an output file. 
You can accept the default path or type your own one in the File field. You can also use the 
Choose button to locate the necessary file. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
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ings pane of the Virtual Machine Configuration dialog, you can configure the 
sound device 

Sound Settings 

In the Sound Sett
settings. 
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option if you want to enable the sound device in the virtual machine. To 
operations with the sound device without deleting it from the virtual 

Note: The  option can be selected or cleared only when the virtual machine is stopped. 

Enabled. Select this 
temporarily disable 
machine configuration, clear this option. 

Enabled

Connected. Select this option to have the sound device automatically connected on the virtual 
machine startup. 

Output. Use the output list to choose the necessary device. You can choose one of the following 
devices: 

 Default. Select this option if you want to use the input device set as default in the primary 
operating system. 

 Null device. Select this option if you want to mute the output device. 
 Built-in output. Select this option if you want to use one of the output devices connected to 

the primary operating system. 

Input. Use the input list to choose the necessary device. You can choose one of the following 
devices: 

 Default. Select this option if you want to use the input device set as default in the primary 
operating system. 

 Null device. Select this option if you want to mute the input device. 
 Built-in input. Select this option if you want to use one of the input devices connected to the 

primary operating system. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
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achine Configuration dialog, you can enable the USB 
controller support in your virtual machine. A virtual machine can emulate only one USB 

t 
USB 1.1 devices to the virtual machine. 

USB Settings 

In the USB Controller pane of the Virtual M

controller, which provides you with the possibility to connect up to eight USB 2.0 and eigh

 

Enabled. Select this option to allow using USB devices in the virtual machine. If you want to 
temporarily disable USB operations without deleting the USB controller from the virtual 
machine configuration, clear this option. 

If the USB controller is disabled, such USB devices as keyboard, mouse, microphone will still 
be available to the virtual machine with other emulated subsystems, such as sound, keyboard or 
mouse emulation, etc. 

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
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evice Settings 

devices available in the hardware configuration of the 
Parallels physical server. You may change the device connected to the virtual machine SCSI 
device by choosing it from the list. 

You can also change the device position in the Location list. 

Note: The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI 

Generic SCSI D

To view and edit the settings of a generic SCSI device used by the virtual machine, use the 
Generic SCSI pane of the Virtual Machine Configuration dialog. 

The SCSI device list displays the SCSI 

controller itself. 

You may add a brief description of the device in the Description field. 

When you finish configuring the hard disk settings, click OK to save the changes and quit the 
Virtual Machine Configuration dialog. If you do not want to save the changes, click Cancel. 
 

Intel VT-d PCI Device Settings 

To view and edit the settings of an intel VT-d PCI device used by the virtual machine, use the 
Intel VT-d PCI device pane of the Virtual Machine Configuration dialog. 

Select the Enabled option to enable this PCI device in the virtual machine. If you want to 
temporarily disable the device, clear this option. 

 connected to the virtual machine's PCI device by 
choosing it from the list. 

The PCI Device list displays the PCI devices available in the hardware configuration of the host 
computer. You may change the device

Note: If you start the virtual machine with the PCI device disabled, you cannot change this 
option when the virtual machine is running. 

For the instructions on adding Intel VT-d PCI devices to virtual machines, see Adding Intel VT-d 
PCI Devices. 

, see 
in Parallels Virtual Machines. 

 

For more information about using Intel VT-d PCI devices in Parallels virtual machines
Using Intel VT-d PCI Devices 
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Adding and Removing Devices 
Adding new devices to a virtual machine is easier than connecting new devices to a real 
computer. Removing or disconnecting devices is also easy. The following virtual devices can be 
added to the configuration or removed from it: 

 virtual hard disk drives 

ters 
 serial ports 

 generic SCSI devices 

ing virtual machine only 
when it is stopped. 

 a real one, you should have system privileges 

 CD/DVD drives 
 floppy disk drives 
 network adap

 printer ports 
 sound devices 
 USB controllers 

 PCI devices 
 Intel VT-d PCI devices 

Any of the aforementioned devices can be added to the correspond

Note: To be able to connect any virtual device to
to access the real device. Otherwise, the real device will not appear in the list of available 
devices even though it is installed on your computer. 

Adding a New Device to a Virtual Machine 

2 Click the  button at the top of the Virtual Machine Configuration dialog to open the 

Add button 

1 Choose Configure from the Virtual Machine menu to open Virtual Machine Configuration. 

Hardware
pane for editing hardware devices. 

3 Click the  in the bottom part of the Virtual Machine Configuration dialog and 

chine is running. You need to stop the 

select the device to be added to your virtual machine. 

Note: The Add button is disabled when the virtual ma
virtual machine before you can use this button. 
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4 If you selected any device except for a hard disk, the corresponding device with a typical 

 parameters: 

 The hard disk type: a new image file or an existing one. Select Boot Camp if you want 

 on the physical server to an existing image file 
 for the new image file. 

 size for the new hard disk image file. 

ard disk image file, you can choose one of the following formats: 
n. By default, the hard disk will have the expanding format. To create 

ard disk, clear the Expanding disk option. If you want the virtual hard disk to be 
ct the Split the disk image to 2 GB files option. For more information on hard 

refer to Support for Virtual and Real Disks (p. 106). 

configuration is added at once and ready for use. 

If you selected a hard disk, you should specify some

to add an existing Boot Camp partition as a hard disk to your virtual machine (available 
for Parallels Server for Mac only). 

 The hard disk location. Provide the path
or the path and name

 The hard disk

 For the new h
expanding or plai
a plain h
split, sele
disk formats, 
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perating system installed inside the virtual 
on on how to initialize the 
0). 

 to open Virtual Machine Configuration. 

ine Configuration dialog to open the 

Click OK, to add the hard disk. After you added a new virtual hard disk to the virtual 
machine configuration, it will be invisible to the o
machine until the moment you initialize it. For detailed informati
newly added hard disk, see Initializing the Newly Added Disk (p. 12

Once the new device is added, you can manage its properties as usual and start using it. 

Removing Devices From the Virtual Machine Configuration 
1 Choose Configure from the Virtual Machine menu

2 Click the Hardware button at the top of the Virtual Mach
pane for editing hardware devices. 

3 Select the device you want to remove and click the Remove button  in the bottom part of 
the Virtual Machine Configuration dialog. 

Note: If you accidentally click the Remove button , click Cancel in Virtual Machine 
Configuration. Once you click OK, the device will be removed. 
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Initializ
Aft nfiguration, it will be 

ent you 

nagement. 

you open the Disk Management utility, it automatically detects that a new hard disk was 
added to the configuration and launches the Initialize and Convert Disk wizard: 

1 In the introduction window, click Next. 
2 In the Select Disks to Initialize window, select the newly added disk and click Next. 
3 In the Select Disks to Convert window, select the newly added disk and click Finish. 

The added disk will appear as a new disk in the Disk Management utility window, but its 
memory space will be unallocated. To allocate the disk memory, right-click this disk name in 
the Disk Management utility window and select New Simple Volume in Windows Vista or New 
Volume in Windows XP. The New Simple Volume Wizard/New Volume Wizard window will 
appear. Follow the steps of the wizard and create a new volume in the newly added disk. 

After that your disk will become visible in Computer/My Computer and you will be able to use it 
as a data disk inside your virtual machine. 

Initializing the New Virtual Hard Disk in Linux 

Initializing a new virtual hard disk in a Linux guest OS comprises two steps: (1) allocating the 
virtual hard disk space and (2) mounting this disk in the guest OS. 

To allocate the space, you need to create a new partition on this virtual hard disk using the 
fdisk utility: 

Note: To use the fdisk utility, you need the root privileges. 

ing the Newly Added Disk 
er you added a new blank virtual hard disk to the virtual machine co

invisible to the operating system installed inside the virtual machine until the mom
initialize it. 

Initializing the New Virtual Hard Disk in Windows 

To initialize a new virtual hard disk in a Windows guest OS, you will need the Disk 
Management utility available. For example, in Windows 7 and Windows XP you can access this 
utility by doing the following: 

 In Windows 7, click Start > Control Panel > System and Security > Administrative Tools > 
Computer Management Storage > Disk Ma

 In Windows XP, click Start > Control Panel > Administrative Tools > Computer Management 
> Storage > Disk Management. 

When 

1 Launch a terminal window. 

2 To list the IDE disk devices present in your virtual machine configuration, enter: 
fdisk /dev/hd* 

Note: If you added a SCSI disk to the virtual machine configuration, use the fdisk 
/dev/sd* command instead. 

3 By default, the second virtual hard disk appears as /dev/hdc in your Linux virtual 
machine. To work with this device, enter: 
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fdisk /dev/hdc 

sk /dev/sdc command instead. Note: If this is a SCSI disk, use the fdi

4 To get detailed information about the disk, enter: 
p 

5 To create a new partition, enter: 
n 

6 To create the primary partition, enter: 
p 

7 Specify the partition number. By default, it is 1. 

8 Specify the first cylinder. If you want to create a single partition on this hard disk, use the 
default value. 

9 Specify the last cylinder. If you want to create a single partition on this hard disk, use the 
default value. 

10 To create a partition with the specified settings, enter: 
w 

When you allocated the space on the newly added virtual hard disk, you should format it by 
entering the following command in the terminal: 
mkfs -t <FileSystem> /dev/hdc1 

Note: <FileSystem> stands for the file system you want to use on this disk. It is 
recommended to use ext3 or ext2. 

When the added virtual hard disk is formatted, you can mount it in the guest OS. 

1 To create a mount point for the new virtual hard disk, enter: 
mkdir /mnt/hdc1 

Note: You can specify a different mount point. 

2 To mount the new virtual hard disk to the specified mount point, enter: 
mount /dev/hdc1 /mnt/hdc1 

When you mounted the virtual hard disk, you can use its space in your virtual machine. 
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Managing Virtual Machin

This chapter provides information on the 
on 

 cloning a virtual machine (p. 123) 
 deleting a virtual machine (p. 125) 
 working with v
 managing virtual machines from the notification area (p. 133) 
 working with snapshots (p. 
 migrating virtual machines (p. 139) 
 working with virtual machine backups (p. 140) 
 compressing virtual hard disks 

In This Chapter 
Cloning a Virtual Machine..................

Managing Virtual Machine Templates ..............................................................
Managing Virtual Machines From the Tray .........................................................................
Working With Snapshots .........................................................
Migrating a Virt
Working With Virtual Machine Backups ...........
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Cloning a Virtual Machine 
If you need to create an exact copy of a virtual machine, to back it up or for some other 
purposes, use: 

sed physical computer) 
if Parallels Management Console is installed on a Mac-

n as the original virtual machine does. If a 
source, in the cloned virtual 
e. 

llel or serial port connected to an output file, 

 Clone Virtual Machine Wizard (if Parallels Management Console is installed on a 
Windows- or Linux-ba

 Clone Virtual Machine Assistant (
based physical computer) 

The cloned virtual machine has the same configuratio
device in the original machine was connected to an external re
machine, this device will be connected to the same external resourc

Notes: 1. If the original virtual machine has a para
the virtual machine clone will have empty output files. 

in the original configuration, a new MAC address will be 
gen chine clone. 
2. If a network adapter is enabled 

erated for the virtual ma

Before y

To 

1 
2 
3 

 choosing Clone from the File menu 

 right-clicking the virtual machine in the sidebar and choosing Clone form the shortcut 
menu 

4 In the Name and Location window, type the name of the virtual machine clone and specify 
the folder for its files to be stored. You can use the Choose button to locate the folder. 

By default, the files of the virtual machine clone will be placed to the following folder: 

 Mac OS X: /Users/Shared/Parallels/<Virtual_Machine_Name>/ 

 Parallels Server Bare Metal: /var/parallels/<Virtual_Machine_Name> 

 Parallels Server for Mac Bare Metal Edition: 
/var/parallels/<Virtual_Machine_Name> 

ou start cloning a virtual machine, make sure that the virtual machine is not running. 

clone a virtual machine: 

Launch Parallels Management Console. 

In the sidebar, select the virtual machine you want to clone. 

Start Clone Virtual Machine Wizard by doing one of the following: 
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When finished, click Clone. 

5 When the operation is complete, click Done in the Cloning Finished window. 

nt The clone of the virtual machine will appear in the sidebar of the Parallels Manageme
Console window. 
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Deleting and Removing a Virtual 
Machine 

If you do not need any of your virtual machines, you can either temporarily remove or delete it 
from Parallels Management Console. 

When removing a virtual machine from Parallels Management Console, you do not remove the 
virtual machine files from the Parallels server. You can easily add the removed virtual machine 
back to the virtual machines list with the help of Add Existing Virtual Machine Assistant. For 
more information about adding existing virtual machines, see Adding an Existing Virtual Machine 
(p. 64). 

Deleting a virtual machine means permanently erasing its files from the Parallels server. Make 
sure you transferred all the necessary data from the virtual machine before deleting it: this 
operation is irreversible. All the virtual machine data will be lost. 

You ne using Delete Virtual Machine Assistant (or Delete Virtual 
Machine Wizard if Parallels Management Console is installed on a Windows- or Linux-based 

u can delete a 
virtual m
Ass

By default, Delete Virtual Machine Assistant removes all files that are stored in the virtual 
machine folder, including: 

 configuration file 
 virtual hard disk file(s) 
 floppy disk image file(s), if any 
 output files of serial and parallel ports, if any 

To delete a virtual machine or remove it from the list: 

1 Launch Parallels Management Console. 

2 In the sidebar, select the virtual machine you want to delete or remove from the list. 

3 Start Delete Virtual Machine Assistant by doing one of the following: 

 choose Remove from the File menu 

 click Remove in the Operations section of the virtual machine Summary tab 

Note: Before deleting a virtual machine, make sure that the virtual machine is stopped. 

 can delete a virtual machi

physical computer) that finds and deletes all the virtual machine files. Or yo
achine manually. However, we recommend that you use Delete Virtual Machine 

istant. 

4 In the Delete Options window, select the operation you want to perform on the virtual 
machine. 

 To delete the virtual machine, select Delete and click Continue. 

 To remove the virtual machine from the list, select Remove from list and click Remove. 

Note: If you remove the virtual machine from the list visible in Parallels Management 
Console, its files will not be removed from the Parallels server. You will be able to add this 
virtual machine back. 
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5 If you chose to delete the virtual machine, you would be presented with the Files Selection 
window. This window displays all the files that belong to the virtual machine.In the File 
Selection window, choose the virtual machine files to be deleted from the Parallels server 
and click Delete. 

The assistant automatically selects the files that belong to the virtual machine, such as: 

 VM Configuration File. The file has the .pvs extension and defines hardware and 
resources configuration of the virtual machine. 

 Hard Disk Image. The file has the .hdd extension and represents a virtual hard disk of 
the virtual machine. 

 Floppy Image. The file has the .fdd extension and is a floppy disk image file. 

 File. The file has the .DS_Store extension and is a hidden file created by the host OS 
to store custom attributes of a folder. 

 Logging File. The file has the .log extension and serves to record the data. 

 

6 Once the operation is complete, click Done to exit the assistant. 
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Managing Virtual Machine 
Templates 

imilar configuration, you can create a 

s to create a virtual machine template: 

he virtual 

e virtual machine will be available as a template 

machine, you make its exact copy and can use it to create virtual machines with the same 
configuration. 

 

If you need to create several virtual machines with a s
virtual machine template and use it as the basis for creating new virtual machines. 

You can use one of the following way

 Convert an existing virtual machine into a virtual machine template. In this case, t
machine will be moved from the virtual machines list to the templates list once the 
conversion is complete. It means that th
only (i.e. you will not be able to run it). 

 Clone an existing virtual machine to a virtual machine template. By cloning a virtual 
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xisting virtual machine into a template: 

 virtual machine you want to convert into a template by clicking its icon in the 
sidebar. 

ine you want to be cloned to a virtual machine 

allels Management Console is installed on a Mac-based physical computer) 
by doing one of the following: 

 choosing Clone to Template from the File menu 

 right-clicking the virtual machine in the sidebar and choosing Clone to Template form 
the shortcut menu 

4 In the Clone to Template Virtual Machine Wizard Introduction window, click Next. To skip 
this window next time you start the wizard, select Always skip introduction. 

5 In the Name and Location window, specify the name and location for the virtual machine 
template and click Clone. You can use the Choose button to change the location. 

By default, the virtual machine template files will be placed to the following folder: 

 Mac OS X: /Users/Shared/Parallels/<Template_Name>/ 

 Parallels Server Bare Metal: /var/parallels/<Template_Name> 

 Parallels Server 4.0 for Mac Bare Metal Edition: 
/var/parallels/<Template_Name> 

Creating a Virtual Machine Template
To convert an e

1 Choose the

2 Choose Convert to Template from the File menu or right-click the virtual machine icon in the 
sidebar and choose Convert to Template from the shortcut menu. 

The virtual machine will be moved to the templates list. 

To clone a virtual machine to a template: 

1 Launch Parallels Management Console. 

2 In the sidebar, select the virtual mach
template. 

3 Start Clone to Template Virtual Machine Wizard (or Clone to Template Virtual Machine 
Assistant if Par
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6 In the Creation Finished window, click Done to quit 
 

the wizard. 
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Deploying a Virtual Machine Template 
The virtual machine template cannot be run as a virtual machine. To be able to run it as a virtual 
machine, you should create a virtual machine that will have the same configuration the template 
does. 

There are two ways of creating a virtual machine from a template: 

 convert the template to a virtual machine 
 deploy the template to a new virtual machine 

If you convert a virtual machine template into a virtual machine, its icon will be moved from the 
templates list to the virtual machines list, and you will be able to use it as a virtual machine. 

If you deploy a virtual machine template to a virtual machine, Deploy Virtual Machine 
Template Wizard will create a new virtual machine, but the template will not be removed from 
the templates list. 

To convert a virtual machine template into a virtual machine: 

ual machine. 

2 Choose Convert to Virtual Machine from the File menu or right-click the template icon in the 
sidebar and choose Convert to Virtual Machine from the shortcut menu. 

The virtual machine template will be moved from the templates list to the virtual machines 
list. 

To deploy a virtual machine template to a new virtual machine: 

1 Launch Parallels Management Console. 

2 In the sidebar, select the virtual machine template you want to be deployed to a new virtual 
machine. 

3 Start Deploy Virtual Machine Template Wizard (or Deploy Virtual Machine Template 
Assistant if Parallels Management Console is installed on a Mac-based physical computer) 
by doing one of the following: 

 choosing Deploy to Virtual Machine from the File menu 

 right-clicking the virtual machine in the sidebar and choosing Deploy to Virtual Machine 
form the shortcut menu 

4 In the Deploy Virtual Machine Template Wizard Introduction window, click Next. To skip 
this window next time you start the wizard, select Always skip introduction. 

5 In the Name and Location window, specify the name and location for the virtual machine and 
click Deploy. You can use the Choose button to change the location. 

By default, the virtual machine files will be placed to the following folder: 

 Mac OS X: /Users/Shared/Parallels/<Virtual_Machine_Name>/ 

 Parallels Server Bare Metal: /var/parallels/<Virtual_Machine_Name> 

 Parallels Server for Mac Bare Metal Edition: 
/var/parallels/<Virtual_Machine_Name> 

1 In the sidebar, select the template you want to convert into a virt
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6 In the Deployment Finished window, click Done to close the wizard. 

The resulting virtual machine will have the same configuration that the original template had. 
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Managing Virtual Machines From 
the Tray 

When working with Parallels Management Console, you can use the Parallels Management 
Console tray icon (p. 19) to easily manage your running and paused virtual machines: 

 Double-click the tray icon to bring the Parallels Management Console window to focus. 
 Right-click the tray icon to open its context menu where you can see your running and 

paused virtual machines. 

Note: Suspended and stopped virtual machines are not listed in the tray icon context menu. 

Point to a virtual machine and do one of the following: 

 Choose Show Window to bring the virtual machine window to focus. If this window is 
detached, only the detached window will be brought to focus. 

 If the virtual machine is paused, choose the corresponding item to resume, suspend, shut 

ut 

down or restart this virtual machine. 

 If the virtual machine is running, choose the corresponding item to pause, suspend, sh
down or restart this virtual machine. 
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Working With Snapshots 
A snapshot is a saved state of the virtual machine. Snapshots can be created manually or 
automatically when the virtual machine is running. After you make a snapshot, you can continue 

 
ate, 

Note: Snapshots are not backup copies or clones of your virtual machine. You cannot use them 

working with the virtual machine and revert to the created snapshot at any time of your work. 

Snapshots are stored inside the virtual machine bundle, in the Snapshots subfolder. Each
snapshot has a number of files, including the  file that contains the virtual machine's st.sav
the .mem file that contains the memory dump for the virtual machine, and other different files 
of the virtual hard disk. 

alon irtual machine bundle. e without your virtual machine or move them from the v

You may need to make snapshots in the following cases: 

 If you are configuring software that requires a lot of settings, you may want to explore the 
settings functions before selecting them. For testing the settings, create snapshots at 

can always revert to the previous state or create a branch of snapshots starting with the 
particular milestone snapshot. 

 

branching points. 
 If you want to mark milestones in the development process. If something goes wrong, you 
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Snapshots can be created manually or automatically using SmartGuard (p. 86). 

Making Snapshots 

Note: You cannot create a snapshot manually or automatically or revert to a snapshot when 
your virtual machine is paused. 

To make a snapshot manually: 

1 Make sure that you completed all operations of installing, downloading, or writing to 
external devices before taking a snapshot. 

Note: You can create a snapshot at any time. But it is recommended to complete all 
operations of installing, downloading, or writing to external devices before taking a 
snapshot. You should also complete or cancel any transactions performed via the virtual 
machine in external data bases. 

2 Choose Take Snapshot from the Virtual Machine menu or use the Take Snapshot button  
on the toolbar of your virtual machine's window. If the toolbar does not contain this button, 
you can add it to the toolbar. For more information, refer to the Customizing Toolbar section 
(p. 17). 

Note: To make a snapshot, you can also use Virtual Machine Snapshots. Just choose 
Manage Snapshots from the Virtual Machine menu and click the New button. A new snapshot 
will be created. 

3 In the Snapshot Parameters window, you can provide a name and a short description for the 
snapshot. This information and the date of creation will be visible in Virtual Machine 
Snapshots when you hover the pointer over the snapshot icon. 

4 Click OK to take a snapshot. 

After the snapshot is created, you can continue working with your virtual machine current state 
or use any of its snapshots. 

To revert to a snapshot, open Virtual Machine Snapshots by choosing Manage Snapshots from 

the Virtual Machine menu or by clicking the Manage Snapshots button  on the toolbar of the 
virtual machine window. 

To create snapshots automatically, configure the SmartGuard settings. 
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ts 
ell as to manage 

the snapshots. To open Virtual Machine Snapshots, do one of the following: 

 button 

Managing Snapsho
You can use Virtual Machine Snapshots to revert to a specific snapshot, as w

 choose Manage Snapshots from the Virtual Machine menu 

 click the Manage Snapshots  in the toolbar (p. 15) 

Note: To add this button to the toolbar, you should customize the toolbar. To learn how to 
do that, refer to the Customizing Toolbar section (p. 17). 

Usi

 
 
 select a snapshot to revert to 

ng Virtual Machine Snapshots, you can: 

create new snapshots and delete the unused ones 
view the snapshot tree of a particular virtual machine 

Note: You cannot create a snapshot manually or automatically or revert to a snapshot when 
your virtual machine is paused. 

The Virtual Machine Snapshots window consists of the following areas: 

 
 

 if the virtual machine was 

 If you want to delete a snapshot which is parental for some other 

espect to the root state. The second successive 
ay want to return to one 

a new snapshots 
branch will be created. 

When the pointer is hovered over an item, you will see a tooltip message with a short 
description. 

Snapshots Management Pane 

The snapshots management pane includes the buttons necessary for managing the snapshots. 

 The New button. Click this button to create a new snapshot for the present state of your 
virtual machine. 

The snapshots tree pane. 
The snapshots management pane. 

Snapshots Tree Pane 

Snapshot icons appear as screen shots of the guest OS window
running at the time you created a snapshot. 

The left icon with a flag is the root of the snapshots tree - it is the initial state of the virtual 
machine used as the reference point. You cannot delete the root icon. The root icon is visible if 
at least one snapshot exists.
snapshots, you can decide whether to delete only this snapshot or delete it with all the 
subsequent snapshots. 

All snapshots in the snapshots tree are descendants of the root state of the virtual machine. The 
first snapshot contains "differences" with r
snapshot contains differences with respect to the first snapshot. You m
of the previous snapshots and work with it. If you then create a new snapshot, 
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he snapshot you want to go to in the snapshots tree and click this 
your virtual machine to the state saved in this 

 The Go To button. Select t
button to move from the present state of 
snapshot. 

Note: Before you go to a specific snapshot, decide what you want to do with the current 
state of the virtual machine - by default, it will not be saved. To retain the changes made 
since the last snapshot, make a new snapshot. 

 The Delete button. Select the snapshot you want to delete and click this button. If you delete 
 merged into the subsequent 

y when you delete all snapshots in 

an intermediate snapshot, the information it contains will be
snapshot. 

Note: You cannot delete the root icon. It disappears onl
the tree. 

You can also manage snapshots by right-clicking them in the tree: 

 If you right-click the icon that shows the present state of the virtual machine, you can create 

ntermediate snapshot, you can choose to go to it, to delete it 

Going to a Snapshot 
 

apshots by doing one of the following: 

m the Virtual Machine menu 

age Snapshots button 

a new snapshot for this state. 
 If you right-click any other i

alone or with all the subsequent snapshots, or to edit its name and description. 

1 Launch Parallels Management Console and select a virtual machine.

2 Open Virtual Machine Sn

 choosing Manage Snapshots fro

 clicking the Man  in the toolbar (p. 15) 

ou will see the notification about that. Click Yes if 
3 Select the snapshot you want to revert to and click Go To. If you revert to a snapshot from an 

unsaved state of the virtual machine, y
you want to proceed without saving the state. Click No if you want to save the state and then 
go to the needed snapshot. 

Note: If, after the Parallels Server update, you decide to revert to one of the snapshots made 
before the update, you will see the message that a new Parallels Tools update is available. 
We recommend you to install them to work effectively with the virtual machine. 

Deleting a Snapshot 
1 Launch Parallels Management Console and select a virtual machine. 

2 Open Virtual Machine Snapshots by doing one of the following: 

 choosing Manage Snapshots from the Virtual Machine menu 

ng the Manage Snapshots button  in the toolbar (p. 15) 

 to delete and click the Delete button if you want to delete only 
to delete all the snapshots that come after it, right-click the 

 clicki

3 Select the snapshot you want
this snapshot. If you want 
snapshot and choose the Delete Snapshot with children option. 

If you delete an intermediate snapshot, the information it contains will be merged into the 
snapshot that follows it. 
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Note: You cannot delete the root icon, but it gets automatically deleted after you delete all the 
other snapshots. 

Mer

Me lete any snapshot except the last one in the 

 belonging to two branches, the information is merged into the next 
sna

 

ging Snapshots 

rging is performed automatically when you de
branch. When you delete an intermediate snapshot, the information it contains is merged into 
the next snapshot of the same branch. 

If you delete the snapshot
pshot of each branch. 

Note: If you delete the snapshot that comes after the root icon and that belongs to two branches,
the branches will start from the initial state icon directly. 

The snapshots are also merged automatically if you manage the capacity of your virtual hard 

 process via 
re not reflected in the snapshots tree, and the icons of already deleted 
nt in the tree. 

disk with the help of Parallels Image Tool. Before applying any changes to the virtual hard disk, 
Parallels Image Tool merges and deletes all the snapshots except for the last one. Unlike 
merging the snapshots in Virtual Machine Snapshots, the results of merging
Parallels Image Tool a
snapshots are still prese
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Migrating a Virtual Machine 
If you have two or more Parallels servers registered in Parallels Management Console, you can 

ed to distribute the workload between physical servers, 
or in view of an interruption in the source physical server operation. 

ber of virtual machines at a time. However, before migration, you 
should check if the amount of free disk space, CPU numbers, and memory on the destination 

migrate your virtual machines between them. The cases when you need to move a virtual 
machine from one Parallels server (source server) to another (destination server) can be quite 
numerous. A migration can be perform

You can migrate any num

server is enough to run your virtual machine(s). 

To migrate a virtual machine: 

1 Launch Parallels Management Console. 

2 Select a virtual machine in the sidebar. 

Note: You can migrate a virtual machine in any of the following states: running, stopped, 
paused, suspended. 

3 Choose Migrate from the File menu to start the Migrate Virtual Machine wizard (or Migrate 
Virtual Machine Assistant if Parallels Management Console is installed on a Mac-based 
physical computer). 

4 In the Target Server window, select a server to which the virtual machine will be migrated. 
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5 Click Migrate to start the procedure. The virtual machine will be migrated to the specified 

rk with the virtual machine or you may prevent 

Parallels server. 

Warning: After you click Migrate, do not wo
it from being properly migrated to the destination server. Wait till the migration process is 
over. 

 

rking With Virtual Machine Wo
Bac

back up the virtual machines residing on the 
 regular backing up of virtual machines is essential for any 

t has snapshots, the snapshots will not be included 

kups 
Parallels Management Console allows you to 
registered Parallels servers. A
physical server reliability. 

Note: If you back up a virtual machine tha
into the backup, and as a consequence, a virtual machine restored from this backup will have no 
snapshots either. 

To work with virtual machine backups, select a virtual machine in the sidebar and go to the 
Backup tab. If the virtual machine has any backups, the information about these backups is 
available on the Backup tab: 

Column Name Description 
ID The ID assigned to the backup archive. 

Date The date when the backup archive was created. 

Size The size of the backup archive, in megabytes. 

Type The backup type: 

 A full backup indicated by f. 
 An incremental backup indicated by i and containing only the files 

changed since the previous full or incremental backup. 
Description Description of the backup archive. 

The Backup tab also contains the necessary controls allowing you to create a new backup, to 
restore a backup, or remove it from the Parallels server. More detailed information on how to do 
these operations is given in the following subsections. 
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B al Machine 
To 

Note irtual machine are not included in the backup, and the restored virtual 

acking Up a Virtu
back up a virtual machine, do the following: 

: The snapshots of a v
machine will not have any snapshots. 

1 Select the virtual machine in the sidebar, and clic

2 Click the

k the Backup tab. 

 New button. The Back Up Virtual Machine window appears. 

 

3 In this window, sele

 if the virtual machine has a full backup. 
An incremental backup contains only the files changed since the previous full or 
incremental backup. 

You can also add a short description to the backup. 

4 Click OK. 

Note: Backing up a virtual machine may take you some time. Do not work with the virtual 

ct the backup type: 

 Full. If the virtual machine has no backups at all, you will be able to choose only this 
backup type. 

 Incremental. This backup type is available only

machine until the procedure is over. 
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al Machine Backups 
wing: 

ant to restore, and click Restore. 

Restoring and Removing Virtu
To restore a virtual machine backup, do the follo

1 Select a virtual machine in the sidebar, and click the Backup tab. 

2 On this tab, select the backup you w

 

Note: Restoring a virtual machine backup may take some time. Please wait until the procedure 
is over. 

To remove a virtual machine backup, do the following: 

1 Select a virtual machine in the sidebar, and click the Backup tab. 

2 On this tab, select the backup you want to remove, and click Delete. 
 



 
 

 

Parallels Compressor is an easy-to-use Parallels utility which will help you keep your virtual 
machines efficient for many purposes. 

Parallels Compressor is a part of the Parallels Tools set and is installed, updated, and removed 
with Parallels Tools. To start Parallels Compressor, choose Run Parallels Compressor from the 
Virtual Machine menu. 

Parallels Compressor allows users to: 

 effectively clean up disk space in a virtual machine 
 significantly reduce the size of virtual hard disks files 
 efficiently use the resources of a physical hard disk 

Note: Compressing of a virtual machine cannot be performed if the virtual machine has the 

C H A P T E R  8  

Undo disks option enabled, or if it has snapshots. Compressing is also unavailable for the virtual 
machines with plain disks. 

If, nevertheless, you want to compress the virtual machine that has snapshots, delete all the 
snapshots with the help of Snapshot Manager before you start compressing the virtual machine's 
disks. For more information, refer to Managing Snapshots (p. 136). 

irst disable the Undo disks feature in 

Guest Operating System Requirements ................................................................................ 144 
Parallels Compressor Working Principles ............................................................................ 145 
How to Run Parallels Compressor ........................................................................................ 146 

 
 

Using Parallels Compressor 

To compress the virtual machine with Undo Disks, f
Virtual Machine Configuration. 

In This Chapter 
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Guest Operating System 
Requirements 

Parallels Compressor supports the following guest operating systems: 

32-bit operating systems: 

 Windows 2000 Server SP4, Professional SP4 
 Windows XP Professional SP2, SP3, Home SP2, SP3 
 Windows Server 2003 Web, Standard, Enterprise, Datacenter SP2, R2 

ltimate, Enterprise SP0, SP1 

 

 Windows Vista Home, Business, U
 Windows 2008 

64-bit operating systems: 

 Windows XP Professional SP2 
 Windows Server 2003 Web, Standard, Enterprise, Datacenter SP2, R2 
 Windows Vista Home, Business, Ultimate, Enterprise SP0, SP1 
 Windows 2008 
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rking Parallels Compressor Wo
Principles 

Compressor processes a virtual machine in the following way: 

 defragments virtual disks and cleans up unused space 

epend upon the running mode: 

current system disk 

e you are able to choose disks to compress and actions to perform 

des and other Compressor properties can be found in Parallels 
Compressor Help. 

pression of a virtual 
ure consists of two steps: 

 a preparatory step performed in the guest operating system (deleting temporary and 
unnecessary files, defragmenting virtual disks and cleaning unused disk space); 

 a compacting step (reducing the size of the virtual disk files) performed in the primary 
operating system. 

 

 compacts virtual disks 

The actions performed on your particular virtual machine d

 in automatic mode Parallels Compressor compresses only the 
performing the pre-defined set of actions 

 in manual mod

More about running mo

Steps of the Compression Procedure 

Parallels Compresso
machine. The proced

r is designed to perform the most efficient com
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or How to Run Parallels Compress

Before Starting Parallels Compressor 

ing it or by copying its hard disk 
ual machine in case you do not 

Before starting the utility, back up your virtual machine by clon
files to a safe location. This will allow you to restore your virt

ression. like the results of the comp

Warning: The result of virtual machine compression is irreversible. 

To start Parallels Compressor: 

1 Start the virtual machine you want to compress. 

2 Log in to the guest operating system as a user with administrator rights. 

Note: To run Parallels Compressor in a virtual machine you must have administrator rights 
in the guest operating system. 

3 Choose Run Parallels Compressor from the Virtual Machine menu. 

mpressor runs as a wizard which helps you select the options of 
virtual machine compression. 

When you start Parallels Compressor, you will see the dialog box with a time indicator. The 
time indicator shows the time remaining until Parallels Compressor will run in automatic mode 
(timeout is about 10 seconds). 

Running Parallels Compressor 

Parallels Compressor has the following running modes: 

 automatic, the default mode. In this mode Compressor uses the default compression 
options. 

  manual, Parallels Co
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To run Parallels Compressor: 

 the timeout expires. 
 in manual mode, press the ESC key or click the  button on the dialog box 

before the timeout expires. 
 Compressor in these modes is given in Parallels 

Finish pressor. 
 

 in automatic mode, do not do anything, just wait until
Manual Mode

 Detailed information about running
Compressor Help. 

After Compressing Is Finished 

When the compressing is complete, click  to exit Parallels Com



 
 

 

nformation about issues that may pose a problem when running Parallels 
e solutions for these problems. 
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Getting Technical Support 

This chapter provides i
Management Console and possibl

In This Chapter 
Getting Technical Support

If you have problems with using Parallels Management Console, please view Parallels 
Management Console FAQs first. 

Parallels Technical Support team is ready to help: describe your problem and submit a FREE 
support request to Parallels Support team (http://www.parallels.com/support/). 

To discuss your problem online, visit Parallels Forum (http://forum.parallels.com/).  

Telephone support is available on a per incident fee basis. For more information, visit the web 
page of Parallels Support team (http://www.parallels.com/support/). 
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Troubleshooting and Limi s tation
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Reporting a Problem to the Parallels 
Support Team 

To help improve the quality of Parallels Server, you can send problem reports to Parallels 
support team. If a fatal error occurs in a virtual machine, Parallels Management Console 
automatically opens the Parallels Problem Report window prompting you to send a report. If you 

ual machine behavior, you can create a report manually by choosing 
 the Help menu and filling out the form. Parallels Management Console 

will create a status report and make a screen shot of the running virtual machine. 

t 

notice an unusual virt
Report a Problem from

Note: Parallels team collects error reports and uses them for identifying performance issues, bu
does not respond to them. If you need assistance in resolving the issue, visit Parallels forum or 
Support page, or log us a support call. 

The Parallels Problem Report window looks like the following: 
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In the Specify the problem type field, you can select your problem from the list. In the next field, 
onal. 

.txt
 contains the product version and activation data, primary and guest OSs 

ne configuration and system data information, processor status, etc. 

 its location on 

put on the primary OS desktop whenever you create a 
problem ary OS Screenshot icon to see the screen shot. 

In the Contact Name and Contact e-mail fields, type your name and e-mail. This information will 
be used by the Parallels support team to address you for more technical details if needed. 

Sending a Report 

After you revise the problem report components, click Send Report. The report will receive its 
unique id number and will be sent to the Parallels support team. 
 

you can add a short problem description. These two fields are opti

The Technical Data option includes the  status report file that has been generated for the 
error. The status report
information, virtual machi
Click the Technical Data icon to view the .txt file and to choose the sections that will be added 
to the report. The file is saved on the host computer. If you want to locate it, click the Go To File 
button. 

The Guest OS Screenshot option includes the session screen shot of the guest OS in a .png 
format. This option is available if you create a problem report during the virtual machine 
session. Click the Guest OS Screenshot icon to see the screen shot and the path to
the host computer. 

The Primary OS Screenshot option includes the session screen shot of the primary OS in a .png 
format. This screen shot is made and 

 report. Click the Prim
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Memory Usage Problems 
The amount of the host computer physical memory required for each virtual machine operation 
can be represented as follows: 

Virtual Machine Memory = Guest OS Memory + Video Memory + Virtual Machine Monitor 
Memory 

djust the video memory amount in the Video pane (p. 97) of Virtual Machine 

e Virtual Machine 

virtual 
machines in the Memory tab (p. 31) of the application Preferences. 

u are trying to start one more 
virtual machine, you can come across the memory over commit. The application will inform 
you with the corresponding message. This means that all your running virtual machines require 
more memory that is configured in the Memory tab of the application Preferences. If you start 
one more virtual machine, this may significantly slow down all your virtual machines. To solve 
this problem, you can: 

 stop one or several of your running virtual machines, or 
 edit your virtual machines' configurations to make them consume less memory, or 
 edit the application memory preferences to allocate more memory to your virtual machines. 

 

 Guest OS Memory is the amount of RAM available to your guest OS. You can configure the 
guest OS memory amount in the Virtual Machine Configuration dialog. 

 Video Memory is the amount of physical memory available to the virtual machine's video 
card. You can a
Configuration. 

 Virtual Machine Monitor is the module responsible for the guest operating system 
virtualization. It consumes memory to perform operations of guest virtual devices and  
handle virtual paging emulation. The amount of memory required for th
Monitor operation depends on the guest OS and varies from 50 MB to 200 MB. 

You can configure the whole amount of physical memory available for all running 

Memory Overcommitment 

If you have several virtual machines running at a time, and yo
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oftware Problems With Antivirus S
Because of the close integration with the operating system of the client computer, some actions 
performed by Parallels Management Console may be detected as malicious by the antivirus 
software. 

 such actions are necessary to ensure the proper functioning of Parallels Management 

d. To find out how to 

of Parallels Management Console processes usually start with prl or 

However,
Console. That is why you should prevent the antivirus software from blocking them. If you do 
not want the alerts to appear in future, perform a full system scan using the antivirus software 
and add these processes to the list of trusted ones if no viruses are detecte
do it, refer to your antivirus software Help. 

Note: The names 
parallels. 
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Upgrading or Installing Parallels 
Tools in Text Mode in a Linux Guest 
OS

rver that failed to start, switch to another virtual 
console using Ctrl+Alt+F1 and enter your login details. 

to your virtual machine. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be 

 
If the X Server fail to start in Linux virtual machines, you need to install Parallels Tools in text 
mode to fix the problem. 

1 Start the virtual machine. 

2 When you see a message about X Se

3 Choose Install Parallels Tools from the Virtual Machine menu to connect the Parallels Tools 
ISO image 

installed in your guest operating system. To see the list of guest OSs supported by Parallels 
Tools, see Supported Operating Systems (p. 55). 

The prl-tools-lin.iso image file will be connected to the virtual machine's 
CD/DVD-ROM drive. 

4 In the virtual machine console, type the following command to gain the root privileges: 
su 

5 Check if the Parallels Tools CD image is mounted by entering 
mount | grep iso9660 

If this command does not return anything, proceed to the next step. 

If this command returns anything like 
/dev/cdrom on /media/cdrom type iso9660 (ro,exec,nosuid,nodev,uid=0), 

skip the next step and proceed to the following one. 

If this command returns anything like 
/dev/cdrom on /media/cdrom type iso9660 (ro,noexec,nosuid,nodev,uid=0) 

with the noexec option present in parentheses, you need to unmount the disc using the 
following command and then proceed to the next step: 

umount /dev/cdrom 

6 To mount the Parallels Tools installation disc image, enter the following: 
mount -o exec /dev/cdrom /media/cdrom 

Note: /dev/cdrom is the virtual machine's CD/DVD-ROM drive and /media/cdrom is 
the mount point for this device. In some of the Linux operating systems the virtual 
CD/DVD-ROM drive may appear as /dev/hdb and the mount point /mnt/cdrom. Some 
Linux OSs do not have the CD/DVD-ROM mount point. In this case, you should create the 
mount point directory manually. 

7 When the installation disc image is mounted, change the directory to the CD/DVD-ROM 
directory using 

cd /media/cdrom/ 

8 In the CD/DVD-ROM directory, enter the following to launch Parallels Tools installation: 
./install 
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Note: You must have the root privileges to run this command. 

9 Follow the Parallels Tools Installer instructions to com

10 When the installation of Parallels Tools is complete, restart yo

For general information about installing Parallels Tools in Linux, refer to 
T
 

plete the installation. 

ur virtual machine. 

Installing Parallels 
ools in a Linux Guest OS (p. 57). 

Installing the GCC Package and 
Kernel Sources in Linux 

d from Linux distribution disks. 

To 
ente

When installing or upgrading Parallels Tools in a Linux virtual machine, you may need to install 
the gcc package and kernel sources in your Linux guest OS. Kernel sources can be either 
downloaded from the Internet or installe

install the gcc package and kernel sources in the RHEL/Fedora/CentOS Linux distribution, 
r the following command in a terminal: 

yum install gcc kernel-devel 
mak

To nd kernel sources in the Debian/Ubuntu Linux distribution, enter the 

e 

install the gcc package a
following command in a terminal: 
apt-get install gcc make linux-headers-$(uname -r) 

el sources in other Linux 
ocumentation for these distributions. 

If y y to find a solution in Parallels Knowledge Base 
m 

 

Fo  information on how to install the gcc package and kernr
distributions, refer to the d

ou still experience any problems, tr
p://kb.parallels.com/) or refer(htt  to the Parallels support tea

http://www.parallels.com/en/support/desktop/. 



 
 

 

This glossary defines terms and spells out abbreviations used in Parallels Management Console 
y appear in italics. 

s. 

ork connection mode that enables the virtual machine 
to appear as any other computer on the network, with it own IP address and network name. 

client computer where 

tion file specifies virtual machine's devices and 
 when you create a new virtual machine. 

ls Server Bare Metal or Parallels Server for Mac 
installed. This computer hosts virtual machines files. 

Host-only networking. Virtual machine network connection mode that creates a private network 
between the host computer and its virtual machines, which makes the virtual machine available 
from the host computer only. 

Localhost. Physical computer where both Parallels Server and Parallels Management Console, 
that you use to manage virtual machines, are installed. 

Parallels Management Console. Client application that provides graphical user interface for 
managing Parallels Server Bare Metal or Parallels Server for Mac, their virtual machines, 
preferences, and settings. 

Parallels Physical Server. A physical server where Parallels Server Bare Metal or Parallels 
Server for Mac is installed. This computer hosts virtual machines files. 

Plain format. A virtual hard disk format. A plain virtual hard disk image file resides on your host 
computer and has a fixed size that cannot be changed. 

C H A P T E R  1 0  

Glossary 

User's Guide. References to terms defined elsewhere in the glossar

Administrator. A user with server administration privilege

Bridged networking. Virtual machine netw

Client computer. A computer where Parallels Management Console is installed. 

Client operating system (client OS). An operating system of a remote 
Parallels Management Console is installed. 

Configuration file. See PVS file. Configura
resources. It is created automatically

Expanding format. A virtual hard disk format. An expanding virtual hard disk image file resides 
on your host computer and is small initially. Its size grows as you add applications and data to 
the virtual hard disk in the guest OS. 

Guest operating system (guest OS). Operating system that runs under the virtual machine 
control.  

HDD file. A virtual hard disk file used by the virtual machine. 

Host computer. A physical server where Paralle
is 
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nvironment (PXE). An environment to boot computers using a network 
ently of available data storage devices (like hard disks) or installed operating 

achine configuration file that contains information about the virtual 
machine resources, devices and other settings. 

ed 

l machines that 

Preboot Execution E
interface independ
systems. 

PVS file. A virtual m

Virtual hard disk. A file or a group of files that emulates virtual machine's hard disk. 

Virtual Machine. A virtualized PC environment in which an operating system can be install
and run just like in a physical computer. 

Virtual machine files. Files stored in the virtual machine folder. Virtual machine has at least two 
files: configuration file and virtual hard disk file. 

Virtual machine template. A virtual machine that can be cloned to multiple virtua
will have the same configuration that the virtual machine template had. 

VM. See Virtual Machine. 
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